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Introducing Borland StarTeam 2009
Installation Documentation
This chapter is an overview of Borland StarTeam product installation, and describes the installation instructions
included in the Installation Guide.

Included in this Installation Guide
This document provides installation instructions for these Borland StarTeam products:
•
•
•
•

Borland StarTeam Server 2009 (for Windows and Linux)
Borland StarTeam Cross-Platform Client 2009
Borland StarTeam Web Server
Borland StarTeamMPX (for Windows and Linux) including:
•
•
•

•

StarTeam Workflow Extensions including:
•
•
•

•

StarTeam Event and File Transmitters (installed with the StarTeam Server 2009 installation)
StarTeam Message Broker
StarTeam Cache Agent

StarTeam Extensions
StarTeam Workflow Designer
StarTeam Notification Agent

StarTeam Layout Designer

In addition, this manual covers:
•
•
•
•

Database configuration for Microsoft SQL Server and Oracle.
Upgrading server configurations.
Supporting software installation and configuration.
Data locations.

See the next section for a complete list of StarTeam products and how to access them.

Accessing Borland StarTeam Products and Installation
Instructions
The following sections provide a summary of Borland StarTeam products, where you can get them, and where
you can find the installation instructions for them.

Introducing Borland StarTeam 2009 Installation Documentation
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Products Included with StarTeam Enterprise Licenses
The following table provides a summary of Borland StarTeam products, where you can get them, and where
you can find their installation instructions.
Web Download

DVD Set for
Windows

Consolidated
Separate
Installation Guide
Installation Guide
(this manual)

Yes

Yes

Yes

StarTeam Cross-Platform Client 2009

Yes

Yes

Yes

StarTeam Web Client

Yes

Yes

Yes

Borland LDAP Quickstart Manager

Yes

Yes

Borland StarTeam 2009
StarTeam Server 2009 - Windows
+

StarTeam Layout Designer
*

StarTeam SDK (complete)

StarTeamMPX (Message Broker and
Event Transmitter)

Yes
Yes

Yes

Yes

Yes

Yes
Yes

Yes

+

Multiple versions can be downloaded for various non-Windows platforms including a Universal Client.

*

StarTeam SDK runtime is installed with clients automatically; this entry refers to the full SDK used by developers
to create additional applications that use the StarTeam Server.

Products Included with StarTeam Enterprise Advantage
Licenses
In addition to the products included with StarTeam Enterprise licenses, StarTeam Enterprise Advantage licenses
also include the products listed in the table below. The following table provides a summary of Borland StarTeam
products, where you can get them, and where you can find the installation instructions for them.
Borland StarTeam 2009

Web Download

DVD Set for
Windows

Consolidated
Separate
Installation Guide
Installation Guide
(this manual)

StarTeam Cache Agent

Yes

Yes

Yes

Yes

Yes

Yes

StarTeam Workflow Extensions
(StarTeam Extensions, StarTeam
Workflow Designer, StarTeam
Notification Agent)
Borland Search
*

StarTeam Datamart
*

2

Yes

2

Yes

Controlled
Controlled

Can be purchased separately and added to the Enterprise package.

2

Purchase of Enterprise Advantage enables access to the controlled download page.

10
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StarTeam Integrations
The following table provides a list of the StarTeam Integrations, where you can get them, and where you can
find the installation instructions.
DVD Set for
Windows

Consolidated
Separate
Installation Guide
Installation Guide
(this manual)

Borland StarTeam 2009

Web Download

StarTeam Visual Studio Integration

Yes

Yes

StarTeam Microsoft SCC Integration

Yes

Yes

StarTeam Microsoft Project Integration Yes

Yes

StarTeam Edition for Eclipse
StarTeam Synchronizer for Mercury
TestDirector for Quality Center

Yes

Yes
3

Controlled

Yes

StarTeam Version-Control Add-in for
Yes
Mercury TestDirector for Quality Center

Yes

3

Requires a license purchase prior to download.

Accessing StarTeam Products and What's New
Information
The StarTeam products are available for download from:
http://www.borland.com/downloads/download_starteam.html
You can find out what’s new in StarTeam 2009 by going to Getting Started ➤ What’s New in StarTeam Help
which is available after installation on the Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server 2009
➤ Documentation menu.

StarTeam Replacement Installation DVDs
The primary installation method for the Borland StarTeam products is by downloading the installers at:
http://www.borland.com/downloads/download_starteam.html
However, replacement Installation DVDs are available. If you are installing from DVD, you can install the
products as indicated in Accessing Borland StarTeam Products and Installation Instructions on page 9.
StarTeam’s main installation menu offers these options:
Main Menu Option

Choose to...

Install Products

Display and select from the list of available products from this DVD set.

Browse Documentation

See the list of available StarTeam manuals in PDF format.

Browse Contents

See the contents of the StarTeam installation DVDs. For more information, see
StarTeam Installation DVD Contents on page 12.

Contact Us

Display Borland Corporation address, phone numbers, and links to the Borland
corporate and support web sites.

Introducing Borland StarTeam 2009 Installation Documentation
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StarTeam Installation DVD Contents
The StarTeam DVD contains a launcher for installing the following products, depending on the license version
you purchase:
DVD 1 - Windows Server 32 bit
•
•
•

LDAP
Notification Agent
Server
•
•

MPX Message Broker
MPX Cache Agent

DVD 2 - Windows Server 64 bit
•
•
•

LDAP (32 bit)
Notification Agent (32 bit)
Server
•
•

•

MPX Message Broker
MPX Cache Agent

Web Server

DVD 3 - Linux Server 32 bit
•
•
•

LDAP (Windows)
Notification Agent
Server for Linux
•
•

MPX Message Broker
MPX Cache Agent

DVD 4 - Client (all available platforms)
•
•
•
•
•

Layout Designer
SDK
Cross Platform Client (VCM, FCM, BCO, STCMD)
Extensions
Workflow Designer

DVD 5 - StarTeam Search (Windows and Linux)
DVD 6 - Datamart (WIndows only)

Borland StarTeam Documentation
The Borland StarTeam documentation set is your guide to using the Borland StarTeam product suite. Borland
StarTeam documentation is provided in two formats: HTML and Adobe PDF. All documentation in both formats
is available from these locations:

12
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•
•

Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Cross-Platform Client 2009 ➤ Documentation
Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server 2009 ➤ Documentation

HTML Documentation
The following documentation is provided in HTML format for StarTeam:
•
•

StarTeam Help: Comprehensive online documentation for all user types. Explains using and administering
StarTeam.
Readme: Contains the latest information about your particular installation including system requirements,
known issues and limitations.

Adobe PDF Manuals
The following documentation is provided in Adobe PDF manuals for StarTeam:
•
•
•

•

Installing StarTeam: The StarTeam Installation Guide (this manual) contains detailed instructions for
installing and configuring the “core” StarTeam products.
Administering and Using StarTeam: This manual is identical to the HTML version of StarTeam Help.
This guide provides comprehensive documentation for both administrators and general users of StarTeam.
StarTeam Extensions User’s Guide: Explains how to design and manage StarTeam Extensions such as
alternate property editors (APEs). It also covers the StarTeam Workflow Designer and StarTeam Notification
Agent.
StarTeamMPX Administrator’s Guide: Explains the basic operation and architecture of a StarTeamMPX
system, and presents instructions on installing and configuring the StarTeamMPX components.
Note: Depending upon which StarTeam products you purchased and installed, not all of the applications
described in the manuals will be on your system.
Important: All manuals distributed in Adobe Acrobat (.PDF) format require the Adobe Acrobat Reader,
7.0 or higher, to display them. The installation program for Adobe Acrobat Reader is available from the
Adobe web site at: www.adobe.com.

Other Product Documentation
Documentation for optional products such as Borland LDAP Quickstart Manager and Borland Search can be
found in the Start ➤ Programs ➤ product_name ➤ Documentation submenu.

Borland Support
Borland Software Corporation is committed to providing world-class services in the areas of consulting and
technical support. Borland has more than 20 years of experience in supporting developers and enterprise
customers. Qualified technical support engineers are prepared to handle your support needs on a case-by-case
basis or in an ongoing partnership. Borland provides worldwide support, delivering timely, reliable service to
ensure every customer's business success.
For more information about Borland's support services, visit the following Borland Web sites:
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•
•
•

http://support.borland.com - Borland Answers, the Borland Technical Support Web site, where registered
users can find product upgrades as well as previous versions of a Borland product.
http://techpubs.borland.com - The Borland Technical Publications Web site, where you can view and
download PDF files that describe the installation, configuration, administration, and use of Borland products.
http://support.borland.com/download.php - The Borland Product Trials Web site, where registered users
can download free product trials.

When contacting support, be prepared to provide complete information about your environment, the product
version, and a detailed description of the problem.
For support on third-party tools or documentation, contact the vendor of the tool.

Documentation Conventions
The following table lists the documentation conventions that this guide uses.
Convention

Object Indicated, Identified, or Represented

Choose File ➤ Exit to...

A menu selection that precedes a submenu selection. The
arrow separates the commands to be selected from
subsequent menus. For example, the phrase Choose File
➤ Exit means to choose File from the menu bar and then
to choose Exit from the resulting drop-down menu.

Fixed-space font

Code, file names, parameters, information that you need to
type, and messages from the system.

Italics

Information that you replace with the names of your files,
child folders, and so forth. Italics also emphasize words and
identify the names of books.

Bold

UI controls and information that one must use exactly as
shown.

[]

Optional syntax.

|

Mutually exclusive choices.
Note:

Tip:

Important:

Caution:

14
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Supplemental information.

Information about alternative procedures or other helpful but
nonessential information.
Information that is essential to the completion of a task.

Actions that might result in a loss of data, or procedures that
one must follow to avoid losing data.

Installation Roadmap
Depending on your role, experience with StarTeam, and what products you are installing, use the appropriate
section below as a guide for the installation process you need to follow.

Roadmap for Upgrading
If you are an existing StarTeam user, please note that some products have special upgrade considerations
and instructions:
•
•

StarTeam Server
StarTeamMPX, specifically StarTeam Cache Agent

For these products, go to the various chapters in this manual for each product to review upgrading instructions:
Upgraded Product

See...

StarTeam Server

Installing StarTeam Server on Windows on page 17

StarTeam Cache Agent

Installing a Cache Agent on page 57

Roadmap for StarTeam Clients
For information about installing the StarTeam clients, see Installing StarTeam Clients on page 41.

Roadmap for Borland StarTeam Server Administrators
If you are the administrator for Borland StarTeam or perhaps the IT Administrator, you install these StarTeam
products on the systems indicated below:
Install this product

On this system...

See...

StarTeam Server

The computer to be used as the
StarTeam Server; this computer must
be accessible to all StarTeam clients.

Installing StarTeam Server on Windows
on page 17

StarTeam Workflow Designer and
StarTeam Extensions

StarTeam administrator's workstation.

Installing StarTeam Workflow
Extensions on page 67

StarTeam Notification Agent

Usually on the same computer as the
StarTeam Server.

Installing StarTeam Notification Agent
on page 72

StarTeamMPX Services (Message
Broker)

On the StarTeam Server computer and Installing the Message Broker on page
possibly in each major geographic
56
location, depending on how you use
StarTeamMPX and StarTeam Cache
Agent. You might install on a

Installation Roadmap
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Install this product

On this system...

See...

network-near computer instead of the
StarTeam Server computer.
StarTeamMPX Cache Agent

One Cache Agent per to serve as the Installing a Cache Agent on page 57
root Cache Agent on the same
computer as the StarTeam Server or on
a computer network near to it. Also, one
remote Cache Agent in each major
geographic location, usually on the
same computer as the remote Message
Broker. Multiple instances can be run.

Borland LDAP Quickstart Manager

StarTeam administrator's workstation.

ST_LDAPInstall.pdf - available on the
Borland Technical Publications Web site
at:
http://techpubs.borland.com/starteam/

StarTeam Layout Designer

StarTeam administrator's workstation.

Installing StarTeam Layout Designer on
page 65

You can download these Borland StarTeam products from the Borland web site at:
http://www.borland.com/downloads/download_starteam.html

StarTeam Integration Roadmap
StarTeam Integrations are downloaded from the Borland web site at:
http://www.borland.com/downloads/download_starteam_integrations.html
After you download the installation executable, go to the appropriate manual and follow the installation
instructions.

16

| Installation Roadmap

Installing StarTeam Server on Windows
This chapter explains how to install StarTeam Server. It also covers the preparations that should be made
before the installation and the steps you need to take after the installation, particularly if you are upgrading
from an earlier release of StarTeam Server.
•
•

If you are evaluating the product for adoption or installing the product for first use on site, you should read
Pre-installation Requirements for a New Installation on page 20
If you are upgrading from an earlier version of the product to a new release, you need to read all of this
chapter. After the installation, you must upgrade each server configuration. See Upgrading to Borland
StarTeam 2009 on page 21

About StarTeam Server
StarTeam Server is a powerful tool that supports distributed development teams and mobile team members.
It supports data in all languages that can be encoded in UTF-8.You can access the data managed by StarTeam
Server using a variety of clients. The primary client most often used is the StarTeam Cross-Platform Client
which supports Windows, Solaris, and Linux operating systems.
Other clients use other means to access the server. For example, StarTeam Web Client can access the server
through Internet Explorer. StarTeam integrations access StarTeam Server from their respective IDE applications
such as Microsoft Visual Studio and platforms such as Eclipse.
Access to StarTeam Server can be local or remote—by way of the Internet, intranet, WAN, or a dial-up
connection. Built-in encryption enables you to work securely over public networks such as the Internet. Normally,
you install StarTeam Server on a computer accessible to all team members. You then install StarTeam clients
on team members’ workstations. To learn to use StarTeam Server, refer to the extensive online help.

System Requirements for StarTeam Server
Borland recommends installing StarTeam Server on a dedicated application server, and installing the database
on a separate server unless you are using Microsoft SQL Server 2005 Express as your database.
Note: There should be a dedicated connection between the computers running StarTeam Server and
the database management system. For optimal performance, both machines should be on the same
physical switch.
The following sections show the minimum and recommended hardware for the computer on which you deploy
the StarTeam Server application and database. Although specific processor speeds are listed, you should
always use the fastest available CPU to maximum performance.

Supported Operating Systems
The following operating systems are supported for this release of StarTeam Server:

Installing StarTeam Server on Windows
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•
•
•
•

Microsoft Windows Server 2003 SP2 (32-bit)
Microsoft Windows Server 2003 R2 SP2 (32-bit)
Microsoft Windows Server 2008 (64-bit)
Red Hat Enterprise Linux 5 Server (32-bit)
Note: You cannot install a 64-bit Windows StarTeam component on a 32-bit Windows system. The installer
will return an error upon attempting to install the Java VM.

Supported Databases
The following databases and ODBC drivers have been tested and are supported for StarTeam Server:
Supported Database

CPU

Version

ODBC Version

Microsoft SQL Server 2005
1
Express

x86 (32-bit)

2005 (SP3)

SQL Native Client 2005
9.00.4035 (32-bit and 64-bit)

Microsoft SQL Server 2005

x86

2005 (SP3)

SQL Native Client 2005
9.00.4035 (32-bit and 64-bit)

Oracle 10R2

32-bit

10.02.00.04

10.02.00.04

Oracle 11g

32-bit

11.01.00.06

11.01.00.06

Oracle 10R2 Client

32-bit and 64-bit

10.02.00.04

10.2.0.4.0

Oracle 11g Client

32-bit and 64-bit

•
•

11.01.00.06 (32-bit)
11.01.00.06 Client patch
14 (64-bit)

11.01.00.06

1

You can install Microsoft SQL Server Express as part of the StarTeam Server installation.

Use the following default passwords in the installer:
•
•

sa: StarTeam123
StarDraw: StarDraw123

The other database products must be purchased from the appropriate vendor. For more information, see
Database Server System Requirements on page 19

StarTeam Server and SQL Express on the Same Computer
When SQL Server Express is used, the database typically resides on the same computer as the corresponding
StarTeam Server application. The following hardware recommendations for a joint StarTeam Server/SQL
Server Express computer are based on the number of seats (registered users)—although your situation might
vary depending on the size of your StarTeam projects and the number of projects managed by the server
configuration.
The following table lists suggested system configuration requirements if you are using SQL Server Express
and StarTeam Server on the same computer.

18

Number of Seats

Recommended Configuration

less than 50

32-bit dual core machine with 4GB of RAM

50 – 100

32-bit quad core machine with 4-8GB of RAM

| Installing StarTeam Server on Windows

Note: SQL Server Express is not recommended for configurations serving more than 100 registered
users.

StarTeam on a Separate Computer
The following hardware recommendations apply when the StarTeam Server application is executing on a
different computer than the database server.They are based on the number of peak users (maximum concurrent
users during peak periods)—although your situation might vary depending on the size of your StarTeam projects
and the number of projects managed by the server configuration.
Number of Peak Users

Recommended Configuration

less than 100

32-bit, dual-core systems with 4GB of memory

100 - 200

32-bit, quad-core systems with 4-8GB of memory

more than 200

64-bit, quad-core systems with 8-16GB of memory

Database Server System Requirements
The following recommendations apply to the database server when it is not on the same computer as the
StarTeam Server. The number of peak users is the maximum number of concurrent users during peak usage
periods.
SQL Server and Oracle databases have been tested only as 32-bit databases. SSE databases have been
tested as 32- and 64-bit.
Number of Peak
Users
less than 100

Hardware Configuration

Database Requirements

Computer with a dual core processor and 4GB Minimum: Microsoft SQL Server Express 2005
of RAM
SP2
Recommended:
•
•

Oracle 10g R2 (10.2.0.4.0) and 11g
(11.1.0.6.0)
Microsoft SQL Server 2005 SP2

100 - 200

Minimum: Computer with quad processors and Minimum and recommended:
4 GB of RAM
• Oracle 10g R2 (10.2.0.4.0) and 11g
Recommended: Minimum configuration plus
(11.1.0.6.0)
RAID system
• Microsoft SQL Server 2005 SP2

more than 200

Minimum: Any high-performance Enterprise
Server with quad processors and 4-8 GB of
RAM

Minimum and recommended:

Recommended: Minimum configuration plus
RAID system

•

•

Oracle 10g R2 (10.2.0.4.0) and 11g
(11.1.0.6.0)
Microsoft SQL Server 2005 SP2

Installing StarTeam Server on Windows
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Third-Party Software Requirements
StarTeam Server uses Sun Microsystems Java Virtual Machine 1.6.0_13 which is automatically installed at
C:\Program Files\Borland\Java\Sun1.6.0_13.
The StarTeam Cross-Platform Client installer runs the Sun tzupdater program on the Sun JRE (1.6.0_13)
installed with this release. The tzupdater program changes the JRE to provide better DST (Daylight Savings
Time) information for Eastern, Mountain, and Hawaiian time zones. It also deletes three JRE files from the
lib/zi folder (if they are there): EST, HST, MST.
Adobe Acrobat Reader is needed to read the StarTeam manuals which delivered in Adobe’s Portable Document
Format (.pdf), and can be viewed with version 7.0 or later of Adobe’s free Acrobat Reader. You can download
the latest version of the Acrobat Reader from Adobe’s web site at http://www.adobe.com.

Large Memory Support
On 32-bit Windows systems, you can use 4GT RAM tuning to enable the StarTeam Server application to utilize
3 GBs of memory. To enable this feature, you must add the /3GB switch to the Boot.ini file. For information
about setting this switch, see:
http://msdn2.microsoft.com/en-us/library/aa366521.aspx
On 32-bit Windows, you should also be aware of the maximum page file size, which can affect memory allocation
when multiple applications are run on the same computer. See the article:
http://support.microsoft.com/kb/237740
You should also be aware of Page Table Entry (PTE) limitations when the /3GB switch is used. See:
http://support.microsoft.com/default.aspx?scid=kb;EN-US;311901

Understanding StarTeam Server Support of Unicode
Character Sets
While StarTeam Server supports data in all languages that can be encoded in UTF-8, it uses only ASCII
characters (0-127) as it expands keywords. Keyword expansion and EOL conversion should work for all
“ASCII-based” encodings, which include UTF-8, Cp1252, and so on. For the various UTF-16 encodings,
StarTeam currently performs EOL conversion, but does not expand keywords.
The internal names of custom fields must be ASCII, but the display names can be in non-English character
sets.

Pre-installation Requirements for a New Installation
Before you install StarTeam Server:
1. Make sure your computer system meets the minimum requirements. For more information, see System
Requirements for StarTeam Server on page 17.
2. You must be a local administrator on the target computer to install StarTeam Server and other StarTeam
products. Also, the local settings for the administrator account performing the install must be stored on the
target computer. StarTeam Server and StarTeam clients will not operate correctly if the local settings are
stored on a network drive.
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3. You must set video settings on the computer on which you install StarTeam Server to 256 colors or higher.
4. Unless you plan to use only SQL Server Express, which is the default database for server configurations,
you must install the database management system you plan to use with StarTeam Server. It is usual to
install the database server on another computer. Make sure your computer system meets the minimum
requirements for the database product. Refer to the documentation supplied with your database management
system for more information. See Database Server System Requirements on page 19 for more information
about supported databases.
Note: There should be a dedicated connection between the computers running StarTeam Server and
the database management system. For optimal performance, both computers should be on the same
physical switch.
5. Install the database client on the same computer as StarTeam Server.
6. If you will be using SQL Server Express, the default database for StarTeam, it is typically installed along
with StarTeam Server on the same computer. If you install from the DVD, you will have multiple copies of
SQL Server Express. One is enough; the installation provides at least two because you may already have
an application using SQL Server Express on the computer where StarTeam Server is installed.The database
files have specific numbers from Microsoft Corporation and the database files with the same number cannot
be used by both applications.
Although SQL Server Express comes with StarTeam Server as the default database, Borland encourages
you to use enterprise-level database management systems unless you have a small team and a relatively
small amount of data.
You can manage SQL Server Express with the SQL Server 2005 Management Studio Express that is
included.
7. Because StarTeam Server can be used with any UTF-8 character set, the code page settings for the
databases can be very important. Information about this can be found in the chapter on creating a server
configuration for your database type.
•
•

For Microsoft SQL Server and SQL Server Express databases, see Understanding the Encoding
Differences on page 75.
For Oracle databases, Database Character Set and StarTeam Server on page 92.

Upgrading to Borland StarTeam 2009
If you have used previous releases of StarTeam Server, you must upgrade each of your server configurations
after installing the new release. The upgrade process varies depending upon:
•
•

Which database you are using.
Which previous release of StarTeam Server you are using.

Your upgrade to StarTeam Server 2009 might require more steps than previous StarTeam Server upgrades.
Be sure to allow time for those steps.

Upgrading Your Current StarTeam Server Patch Level
To determine if a patch is required before you upgrade, contact Borland Technical Support at:
http://support.borland.com.
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Preparing for an Upgrade
Before upgrading, you should do the following:
•

Perform test upgrades.
Borland strongly recommends running test upgrades against copies of current production databases.

•

Create an upgrade schedule.
Plan your server upgrade when it will inconvenience the smallest number of users. A server configuration
cannot be running during some of the steps you take before and during the upgrade. You may want to plan
the server upgrade at the end of the workday or perhaps on a weekend. If you have a large repository or
a slow system, the upgrade process could be time consuming. Depending on the size of your database
and whether you must convert files before upgrading, you might need to schedule several downtimes,
perhaps a series of consecutive weekends. For example, you might schedule one weekend for the
conversions and one for vault verification. If you allow a few weekends for the upgrade process, be aware
that you can continue to use your server configuration on the older release in production between the steps,
but make backups before and after each of these steps to prevent loss of data.
Advise your team ahead of time that you plan to make this transition during a specified period of time, and
advise them when they will need to have the latest version of a StarTeam client installed. Unless specifically
stated, StarTeam clients for a given release work with that StarTeam Server release, one release back,
and one release forward. When an older client works with a newer server, the client cannot access new
features. For example, the older client does not have any new menu commands.

•

Backup the server configuration.
Make certain you have current, verified backups of the files and folders for the server configuration (database
files, archive files, and so on) prior to starting important steps in the upgrade process.

Overview of the Upgrade Process
The following table provides an overview of the upgrade process. See the following sections for more information.
Old Release

New Release

Upgrade Procedure

2008

2009

1. Back up your StarTeam repositories
and other server files.
2. Install StarTeam Server 2009.
3. If necessary, upgrade or migrate
your database to a version
supported by StarTeam Server
2009.
4. Follow the instructions for upgrading
from StarTeam 2008/2008 R2 to
StarTeam Server 2009.

2008 Release 2

Requirements for an Upgrade
This section describes the steps that you follow to upgrade to Borland StarTeam Server 2009, elaborating on
the table provided in Overview of the Upgrade Process on page 22 and providing references to related sections
for more detailed information.
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Before upgrading to Borland StarTeam 2009, you need to:
1. Review the pre-installation issues for a new installation to determine whether any of them apply to you.
See Pre-installation Requirements for a New Installation on page 20.
2. You can upgrade to StarTeam Server 2009 only from StarTeam Server 2008 or 2008 Release 2. If you are
on an earlier release, take the steps necessary to upgrade from that release to StarTeam Server 2008 or
2008 Release 2. See the appropriate installation guides for details. Be sure to also install the latest patches.
You can find information about the latest patches at http://support.borland.com.
3. Back up your StarTeam repositories and other server files. See the documentation for the release of
StarTeam Server that you currently have installed for information about what to back up.
4. You cannot install StarTeam Server while server configurations are running. Therefore, you must perform
one of the following procedures.
Note: Be aware that these procedures use StarTeam Server 2009 as an example. Adjust the procedure
to fit your server.
1. To shut down a server configuration that is not running as a Windows service:
a. Start the Server Administration tool, by selecting Start ➤ Programs ➤ Borland StarTeam ➤
StarTeam Server 2009 ➤ StarTeam Server. The Server Administration window opens.
b. Select the server configuration, and choose Actions ➤ Shut Down Server. After you confirm that
you want to shut down the server, the Status icon changes from “Running” to “Stopping” to “Ready”.
2. If your StarTeam Server configurations run as Windows services, you must stop those services and
change the StarTeam execution mode:
a. Display the Windows Control Panel by selecting Start ➤ Settings ➤ Control Panel ➤ Administrative
Tools ➤ Services. The Services window opens.
b. Locate the StarTeam Server configuration and click Stop.
c. After the service stops, close the Services dialog box and the Control Panel.
d. Stop the server configuration from being run as a service. For example, in StarTeam Server 2008,
start the Server Administration tool by selecting Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam
Server 2008 ➤ StarTeam Server. The Server Administration window opens.
e. Select the server configuration, and choose Actions ➤ Set to Run as Service. This menu command
changes from checked to unchecked, indicating that the server configuration is no longer running as
a service. The server configuration’s icon also changes.
5. Install StarTeam Server 2009 on the same computer as the version of StarTeam Server that you are
upgrading from. For more information, see Installing StarTeam Server on page 26.
6. If necessary, upgrade or migrate your database manager (RDBMS) to a version supported by StarTeam
Server 2009. For more information, see Database Requirements for Upgrading on page 23.
7. Upgrade your server configurations. For more information, see Upgrading Server Configurations on page
25.

Database Requirements for Upgrading
If necessary, you must upgrade or migrate your database manager (RDBMS) to a version supported by the
new version of StarTeam Server. For example, SQL Server 2000 is no longer supported. You must upgrade
to SQL Server 2005 SP2 before upgrading to this release of StarTeam Server.
For more information about which databases are supported by StarTeam Server, see System Requirements
for StarTeam Server on page 17.
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Upgrading from Microsoft SQL 2000 to SQL 2005 SP2
StarTeam Server 2009 does not support the Microsoft SQL 2000 Server. You must upgrade to Microsoft SQL
Server 2005 SP2. The upgrade procedure is:
1. Restore the SQL 2000 database onto a SQL 2005 Server.
2. Upgrade the server configuration using StarTeam Server 2009.

Upgrading from MSDE 2000 to SQL Server 2005 Express SP2
StarTeam Server 2009 does not support MSDE 2000.You can upgrade to Microsoft SQL Server 2005 Express
SP2. The upgrade procedure is:
1.
2.
3.
4.
5.
6.

Backup the database from MSDE 2000.
Restore the MSDE database backup onto the SQL Server 2005 Express SP2.
Install StarTeam Server 2009.
Create a new ODBC DSN which points to the new database.
Copy over the existing server configuration.
Update the server configuration properties with the new database connection:
1. In the Server Administration tool, select your configuration.
2. Choose Configuration Properties from the Server menu.
3. Go to the Database Connection Information page and update it with the new ODBC DSN created in
step 4.

7. Upgrade the database using the StarTeam Server Administration tool:
1. Select your configuration in the Server Administration tool.
2. Choose Upgrade from the Actions menu, or if available, click Upgrade Database on the toolbar.
8. Start the server configuration.

Upgrading from MSDE 2000 to Oracle 10g R2 or 11g
StarTeam Server 2009 does not support MSDE 2000. You can switch to a supported release of Oracle. The
procedure is:
1. Migrate the MSDE database to Oracle 10.2.0.4.0 or 11.1.0.6.0.
2. Upgrade the server configurations using StarTeam Server 2009.

Granting Oracle Privileges
If your server configuration uses an Oracle schema user that was not created automatically by StarTeam
Server, you should check it for all the privileges listed below. These privileges ensure that StarTeam Server
can create labels and perform other operations successfully and should be explicitly defined rather than
relegated to a role.
•
•
•
•
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•
•
•
•
•
•

Create trigger
Create type
Create view
Unlimited tablespace
Create any context
Drop any context

The following procedure explains how to explicitly define Oracle privileges, using the “create type” privilege
as an example.
To explicitly define the “create type” privilege:
1. Log on to the database as system user.
2. Execute the following SQL statement:
grant create type to schema_user
where schema_user is the name of the Oracle schema user.

Upgrading Server Configurations
After you install StarTeam Server 2009, every existing server configuration must be upgraded except for
StarDraw. A new ready-for-2009 StarDraw should have been installed with the server.
To upgrade a server configuration and database:
1. From the Windows Start menu, select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server 2009
➤ StarTeam Server. The Server Administration window opens.
2. Select the server configuration to be upgraded.
Even if the status for the server configuration indicates “Ready”, the server configuration will not start
successfully until you run the upgrade procedure.
3. Click the Upgrade Database toolbar button.
A series of dialog boxes may open and close. At the completion of the process, a message indicates a
successful upgrade operation. If an error occurs, a message displays the error information. The upgrade
process creates a log file in the server configuration's repository folder named DBUpgrade.locale.log where
locale changes (for example, DBUpgrade.en-US.log).
Note: The upgrade process requires one database connection to run. If the upgrade process is unable
to acquire a connection, it will fail.
•
•

Check the database connection information on the StarTeam Server computer.
Ensure that the database is running.

Changes to StarTeam Server Files
The old starteam-server-configs.xml file is copied from the old StarTeam Server release’s installation folder
to the new release’s installation folder.
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Installing StarTeam Server
Before you install StarTeam Server, make sure you read Pre-installation Requirements for a New Installation
on page 20. If you are upgrading from a previous release of StarTeam Server, make sure that you also read
Upgrading Your Current StarTeam Server Patch Level on page 21.
To install StarTeam Server:
1. Close all other Windows applications.
2. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 1
DVD into your DVD drive. The Borland StarTeam Launcher window should appear automatically.
If the installation menu does not appear automatically from inserting the DVD, display it by performing the
following steps:
1. From the Windows Start menu, select Start ➤ Run
2. At the command prompt, type:
x:\setup.exe
where x: is the drive letter of your DVD drive.
3. Press Enter. The StarTeam 2009 installation main menu opens.
3. Click Install Products.
4. Click Server and follow the installation instructions on the screen:
1. For non-English versions, select a language from the drop-down list box, and then click OK.
2. In the Introduction dialog box, read the information, and click Next.
3. In the License Agreement dialog box:
a. Read the agreement.
b. If you agree with the license agreement, click I accept....
If you do not accept the license agreement, you cannot install the product.
c. Click Next.
4. In the Choose Install Set dialog box:
a. Choose either Typical, Compact, or Custom.
•

•

•

Typical - Installs StarTeam Server with the most common options. Recommended for most users.
Those options are Program Files, Sample Server Configuration, SQL Server Express, and the
server’s Online Documentation.
Compact - Installs StarTeam Server with the minimum required options. Only the Program Files
and Online Help are installed. Use this if you will not be using SQL Server Express as a database
and do not want to install the StarDraw Sample server configuration.
Custom - Enables you to choose the options you want to install. Recommended for advanced
users.

Be sure to perform a custom installation if you want to:
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•
•

Enable users to install the StarTeam client over the network from the computer on which StarTeam
Server is installed.
Not install the StarDraw sample repository, for example, because it uses SQL Server Express
and you are not installing that database application either.

b. For a Custom Install only, select (to install) or clear (to bypass) the available options:
•

•

•

•

•

StarTeam Server - If you use the custom installation to install something that was not installed
during a previous installation of StarTeam Server, you may choose to uncheck this check box.
For example, suppose that in a previous custom installation, you elected to bypass the installation
of SQL Server Express. To add that database without reinstalling all of the server program files,
you would clear the StarTeam Server check box.
Client Setup - The client setup files are not automatically part of the server installation. If you
select the Client Setup check box, the StarTeam Cross-Platform Client installer is installed in
the Client Setup folder, a child folder of the StarTeam Server installation folder. Make sure that
this folder is one that all team members can access.
SSE 2005 - SQL Server Express is a variant of Microsoft SQL 2005 offered by Microsoft at no
charge, as long as you comply with their stipulations. SSE2005_ST is installed as part of a typical
installation because it is used as the default database. If you use an enterprise-level database
exclusively (Microsoft SQL or Oracle), you might not be interested in having the SQL Server
Express files added to the server’s computer.
Sample server configuration - Clear this check box if you do not want to install StarDraw.
Installing the StarDraw sample server configuration for this release will not overwrite an existing
StarDraw configuration. However, the StarDraw server configuration in the StarTeam 2009
starteam-server-configs.xml file will refer to the new StarDraw server configuration.
StarTeam Toolbar - Installs the StarTeam Toolbar which remembers passwords so that logging
on is easier.

c. Click Next.
5. In the Choose Install Folder dialog box, click Choose to browse for the location to be used as the
installation folder. (The default location is C:\Program Files\Borland\ StarTeam Server 2009.)
6. Use the MPX Options dialog box to make changes to the MPX profiles used by your server configurations.
If this is the first time that the StarTeamMPX Event and File Transmitters have been installed on this
computer, the installer creates both Event Transmitter and File Transmitter template files using information
from the MPX Options dialog box. These files are stored in a subfolder of the installation folder named
EventServices.
The local host name and IP address are provided at the top of this dialog box for reference purposes.
By default, the Message Broker connection address uses your local computer’s IP address.
a. To specify a different Message Broker for Event Transmitter (and any clients that will use the default
profile), change the proposed Message Broker connection address.
This address must use the format:
tcp:host:port
host is the host name or IP address on which the Message Broker operates
port is the TCP/IP port number (endpoint) with which the Message Broker accepts connections (5101
is the default).
Important: When installing to a computer that has more than one NIC or multiple IP addresses,
do not accept the default server address settings. You must manually enter the correct server
IP address. When the installer detects multiple network addresses on the host computer, it sets
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up default profiles that contain a server-address property whose syntax is invalid (because it
contains multiple addresses).
Tip: You can enter the connection information for more than one Message Broker. In the event
that the Event Transmitter (or a client using the default profile) is unable to connect with the first
Message Broker in the list, it will attempt to connect with the next Message Broker listed. Separate
the address for each Message Broker with a comma (,). For example:
tcp:HostA:5101,tcp:HostB:4999
b. Click Next.
See Chapter 4, “Managing the Transmitters” in the StarTeamMPX Administrator’s Guide for more
information on creating and editing connection profiles.
7. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\ Programs\Borland StarTeam\StarTeam Server
2009).
8. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times
if you want to change the installation options. Then return to the Pre-installation Summary dialog box,
and click Next.
9. If you already had SQL Server Express installed on your computer, enter the password, and click Install.
10. In the Install Complete dialog box, click Done.
5. After you finish installing StarTeam Server, ensure that the permissions on the StarTeam Server installation
folder and files are set correctly. The Windows account for the StarTeam administrator must have full
permissions on the installation folder and files. Set the Windows permissions for all other StarTeam users
in accordance with your company policy. See your network administrator if you need assistance.
If you use the default location, installing StarTeam Server places files in the following folders under your
Program Files folder:
•

Borland\StarTeam Server 2009
This folder and its subfolders contains the executables, DLLs, and utilities used to run StarTeam Server.
This folder also contains the StarTeam_Server_2009_InstallLog.log file, which documents what happened
during the installation process.

•

Borland\StarTeam Server 2009\EventServices
This folder contains the Event Transmitter and File Transmitter template files. It has a subfolder for each
existing server configuration. Inside those subfolders are the MPXEventTransmitter.xml and
FileTransmitter.xml files that will be used by the server configurations. In you have an Enterprise server,
you may want to delete the FileTransmitterTemplate.xml and FileTransmitter.xml files. The file transmitter
is part of Enterprise Advantage only.

•

Borland\StarTeam SDK 11.0
This folder contains the StarTeam SDK Runtime required for most clients to access StarTeam Server.

Known Installation Issue
The SQL Server Express installation can fail due to insufficient registry privileges. The error is similar to the
following:
InstallSQLAgentSecurity failed (computer_name,LocalSystem,203)
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The resolution is to change the security of the HKEY_LOCAL_MACHINE\Software\ Microsoft\Microsoft SQL
Server key to “Full Control”, and then reinstall SQL Server Express. This can be changed using the Windows
registry editor (regedt32).

Post-installation Tasks for a New Installation
If you have not installed StarTeam Server previously, you must perform the following tasks before team
members can begin using StarTeam.
To start using StarTeam Server:
1. Create a server configuration using the StarTeam Server Administrator.
For details about creating a server configuration, see the chapter about your database type:
•
•

Using StarTeam with Microsoft SQL Server and SQL Server Express Databases on page 74
Using StarTeam with Oracle Databases on page 88

When you create a server configuration, you set values for the configuration’s session options, which are
stored in the starteam-server-configs.xml file. Session options specify the core information that StarTeam
Server requires to start a server configuration.
2. Log on to that configuration using the StarTeam Server Administrator.
StarTeam Server comes with a free administrative user with the default name “Administrator” and the default
password “Administrator”.
3. Configure the server using the StarTeam Server Administrator and, for some options, by editing the file
starteam-server-configs.xml.
After the server configuration is created, you can set configuration options, which are stored in the database
for the server configuration. Configuration options enable you to fine-tune server configuration performance
and enable the use of several features, such as:
•
•

Email and audit features
Compression and encrypting of data that is transferred between the server and client workstations

4. Create projects and views using the StarTeam Cross-Platform Client.
5. Add users and groups using the StarTeam Server Administrator.
6. Set the appropriate access rights for the server configuration, projects, and views using the StarTeam
Server Administrator and the StarTeam Cross-Platform Client.
7. If desired, you can run the server configuration as a Microsoft Windows serviceusing the StarTeam Server
Administrator.
See the Administering and Using StarTeam guide for more information about steps 3 through 7.

Post-installation Tasks for an Upgrade
If you are upgrading from a previous release of StarTeam Server, be aware of the following:
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•

•
•

You must upgrade all existing StarTeam server configurations to use the latest release of StarTeam Server.
For more information about upgrading server configurations and creating hives for the Native-II vault, see
Upgrading Server Configurations on page 25.
If you use StarTeamMPX, be sure to install the latest Message Broker and Cache Agents. For more
information, see Installing StarTeamMPX on Windows on page 53.
For more information about installation and upgrade instructions for StarTeam Workflow Extensions, see
Installing StarTeam Workflow Extensions on page 67.

Evaluating StarTeam Server
The first time you run StarTeam Server, an evaluation license is created for StarTeam Enterprise Advantage,
which is the edition of StarTeam with the largest feature set.
Before the 30-day product review period expires, you can extend the evaluation period by contacting Borland
Sales for an extended evaluation key, or by contacting your Borland Account team if you have one.
Be sure to register the product or extend the evaluation period before it expires. Otherwise, when expired
clients access a server configuration managed by StarTeam Server, no components (such as the file or change
request component) are available. In the StarTeam Cross-Platform Client, the upper and lower panes have
no tabs.
To extend the evaluation period for StarTeam Server:
1. After you obtain an extended evaluation key, select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam
Server 2009 ➤ StarTeam Server The Server Administration window opens.
2. Select Help ➤ About from the menu bar. The About StarTeam Server dialog box opens.
3.
4.
5.
6.

Select License in the left pane of the dialog box.
Click Extend Evaluation. The Extend Evaluation dialog box opens.
Enter the evaluation key, and click OK.
Close the About StarTeam Server dialog box.

Licensing StarTeam Server
StarTeam Server can be run as an Enterprise or Enterprise Advantage server which have the following features:
•

•

StarTeam Enterprise provides a basic feature set, including the StarTeam Server, the Cross-Platform and
Web Clients, LDAP Quick Start Manager, StarTeamMPX (Event Transmitter and Message Broker), and
SDK.
StarTeam Enterprise Advantage has all the StarTeam Enterprise features plus the Requirement component,
StarTeamMPX (File Transmitter and Cache Agent), and StarTeam Workflow Extensions which include
alternate property editors (APEs) that enable you to create custom forms and design workflow rules to
control how all the items in a component move from state to state.

Which server you have (or more explicitly, what features a client can access on that server) is determined by
the product license.
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Understanding Licensing
Licenses determine how many users can access StarTeam Server. Users can have either named user or
concurrent licenses. A named user license can be used only by the user who has been assigned that license.
For example, if you have 5 named user licenses and 25 concurrent licenses, the 5 users who receive the
named user licenses are guaranteed access to the server. No one else can use their licenses.
A concurrent license can be used by any user who does not have a named user license. For example, users
without named user licenses receive concurrent licenses on a first-come, first-served basis. After all the
concurrent licenses are in use, users attempting to log on are notified that there are no more licenses available
at this time. They can try again later.
You can add as many users as you choose, but access to the server is granted only to users with named user
licenses or to users who receive concurrent licenses as they log on.
Tip: You can import user information from Active Directory or OpenLDAP and assign users to StarTeam
license types or license server slips using Borland LDAP QuickStart Manager. Refer to the Borland LDAP
QuickStart Manager Administrator Guide for more information. This guide is available on the Borland
StarTeam installation DVD and on the Borland Technical Publications Web site at:
http://techpubs.borland.com/starteam/.
If you have StarTeam named user licenses, you must assign them to specific users in the User Manager
dialog box. Everyone else is assumed to have a StarTeam concurrent license. See the Administering and
Using StarTeam guide for details.
If you have Borland licenses, users must be assigned to the correct slip in the User Manager dialog box,
regardless of their named or concurrent user status. An additional status, Unassigned, may be used instead
of a slip.
The StarTeam Server Administrator is automatically assigned a named user license which cannot be removed.
This is a “free” license that is not counted against the number of named user licenses you have available.

Using StarTeam Licensing
StarTeam Server can be licensed in either of two ways:
•
•

StarTeam licensing, also referred to as native licensing, which is internal to the product
Borland licensing available for use with license servers
Important: BLS should be added to the windows firewall exceptions (on the BLS server machine) when
BLS is started as a windows service. Otherwise StarTeam Server will be unable to connect to the BLS.

If StarTeam users attempt to access a server configuration that is managed by an unlicensed version of
StarTeam Server, the tabs in the upper and lower panes of their StarTeam clients will not display.
Customers buy named Enterprise, concurrent Enterprise, named Enterprise Advantage, or concurrent Enterprise
Advantage licenses for StarTeam Server. Any client can access any server as long as that server recognizes
the user and has a license for that user. Customers usually choose just one method of licensing: StarTeam
native licensing, Borland License Server licensing, or FLEXnet Publisher licensing, but combinations can be
supported. Licensing is handled after the installation, either by setting up a licensing server and putting "slip"
files in the StarTeam Server's \Licenses folder (a child of the server's installation folder) or by registering
StarTeam native licenses using the StarTeam Server Administration tool.
Because StarTeam Server licenses are stackable, you can enter more than one license key so long as all the
license keys are for the same edition (Enterprise or Enterprise Advantage). Be sure to delete the evaluation
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license before entering the first new license. For more information about licensing, see Understanding Licensing
on page 31
When you first register your server, you enter one or two serial numbers: one for named user licenses and/or
one for concurrent licenses. When using multiple serial numbers, they must all identify the same StarTeam
edition.
You can add more named users or concurrent licenses. StarTeam Server keeps track of the total number by
summing the licenses supplied in each serial number or slip. This is referred to as stackable licensing.
Note:
•
•
•

You cannot license StarTeam Server while any of its server configurations are running as a Windows
service.
If you change the registered license while a StarTeam project is open on a user’s workstation, the
licensing takes effect for that user by closing and reopening the project window.
If you license a StarTeam Server as Enterprise after using an evaluation license which is for the
Enterprise Advantage edition, the feature set changes. For example, if you created requirements during
the evaluation and then license the server as anything other than Enterprise Advantage, the requirements
tab disappears.

To license StarTeam Server from the Server Administration tool (native licensing):
1. From the Windows Start menu, select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server 2009
➤ StarTeam Server. The Server Administration tool opens.
2. On the Server Administration menu bar, Select Help ➤ About. The About StarTeam Server dialog box
opens.
3. Select the License node in left pane of the dialog box.
4. If you have yet to enter a license, you must delete the evaluation key by selecting it from the right pane of
the dialog box and clicking Delete.
5. Click Register. The Server Registration dialog box opens.
6. Enter the correct numbers in the Serial Number and Access Key text boxes. Serial numbers are case
sensitive; access keys are not.
7. Click OK.
8. Close the About StarTeam Server dialog box.
Tip: To license a version of StarTeam Server at the command prompt, enter the following:
starteamserver -serial Number -access Key

Using a License Server
You can use Borland License Server or FLEXnet Publisher with StarTeam Server. This gives you a choice
between using a license server and using the StarTeam licensing found in this and earlier releases.
Note:
•
•
•
•
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If you use a license server, users must use their network logon names as their StarTeam user names.
A single license server can handle licenses for multiple StarTeam releases and for multiple product
releases.
FLEXnet Publisher configuration files on Linux are case sensitive.
When StarTeam Server starts up, it checks for slips and stores information about them in memory. It
does not recognize new slips until the next restart.
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•
•

When a user logs in from a StarTeam client application, StarTeam Server tells the client application
what features are available to its user based on the license assigned to that user.
If the user is assigned a license from a slip, but that slip is no longer in the license folder, StarTeam
Server displays an error message. If the license type for that user is Unassigned, the user is not logged
on and StarTeam Server returns an exception.

The administrator does the following to configure the license server:
1. Receives licensing information from Borland through email.
Tip: If you need this information, contact your sales representative.
2. Installs the license server.
Note: Refer to the documentation that is available with the license server.
3. Hosts the licenses sent by Borland. This involves accessing a Borland web site and downloading Borland
license files (slip files).
4. Saves the slip files in the /License folder, a subfolder of the StarTeam Server installation folder.
5. Configures the license server for users. For more information, refer to the documentation that is available
with the license server.
6. Uses the StarTeam Server Administration tool to:
1. Change user names to network logon names.
2. Assign users to specific licenses.

Using the StarDraw Sample Server Configuration
StarTeam provides a sample server configuration named StarDraw. It contains a Visual C++ sample application
and related materials. It has sample files, change requests, topics, and tasks. You can use the StarDraw
sample repository to experiment with and learn more about StarTeam.
During the StarTeam Server installation procedure, the sample server configuration is installed as part of the
Typical installation and can be installed as part of the Custom installation. The installer creates the Sample by
performing the following actions:
•
•
•
•

Copies the stardraw.mdf database into the StarTeam Server
2009\Samples\StarDraw_SSE2005\Database folder.
Copies sample files into the StarTeam Server
2009\Samples\StarDraw_SSE2005\StarDraw\Archives folder and its subfolders.
Creates an ODBC System DSN (Data Source Name) named StarDrawDB110.
Adds the new StarDraw server configuration to the starteam-server-configs.xml file. If a previous StarDraw
server configuration is defined in that file, its settings are updated for the new release’s version of StarDraw.
Important:
In the starteam-server-configs.xml file, the predefined value of ServerGuid for the StarDraw Repository
is:
be5ee3b0-c719-49c6-a1a1-f493764a03f5
Do not change this value. The StarDraw server configuration will not start if you modify the ServerGuid.
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Use the StarDraw server configuration only for experimentation and training—never for live data.

Uninstalling StarTeam Server on Windows
StarTeam Server uses InstallAnywhere for installing and uninstalling. If you encounter one of the following
Java VM errors when uninstalling this product on a Windows system (such as 2003 or XP Pro), you may need
to install JRE 1.6.0_13 or earlier from the Sun website.
Uninstall errors:
•
•
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Can't launch executable. Could not find a suitable Java Virtual machine on your system.
Windows error 3 occurred while loading the Java VM.
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Installing StarTeam Server on Linux
This chapter explains how to install StarTeam Server on Linux.

Migration Strategies
This section outlines the migration strategies to move StarTeam Server from Windows to Linux. Due to the
complexity of the product, Borland recommends that you run the migration in a test environment and that you
develop a backup strategy to deal with any unexpected errors.
The outline provides an experienced StarTeam administrator with the information needed to plan and run a
StarTeam server migration from Windows to Linux.
To perform a migration, both servers, the source Windows server and the destination Linux server must not
be in production use. From a hardware perspective, the Linux server must be configured to support the
production environment. Both servers must be connected and configured so that files can be copied from the
Windows server to the Linux server.

Migrating from StarTeam 2008 Server for Windows to
StarTeam 2009 Server for Linux
The StarTeam 2008 and 2008 R2 Servers for Windows support both Oracle and Microsoft SQL Server relational
database management systems (RDBMS's), while StarTeam 2009 Server for Linux supports only Oracle. For
more details about supported database platforms, see System Requirements and Prerequisites on page 36.
Important: The following steps assume that the original Windows StarTeam configuration you are migrating
uses an Oracle database. If you are migrating a StarTeam 2008/2008R2 for Windows configuration that
uses SQL Server, you must first migrate it to Oracle using the steps specified in the Migrating Server
Configurations to Other Databases topic of the StarTeam 2008/2008 R2 Server for Windows Help. After
you successfully migrate your StarTeam Server for Windows configuration to an Oracle database, you
can proceed with the following Windows to Linux migration steps.
To migrate from Windows to Linux:
1. Back up the current Oracle database (schema used for storing StarTeam 2008/2008 R2 Server for Windows
metadata).
Save this backup copy; do not recycle it.
2. Install StarTeam 2009 Server for Linux on the Linux machine.
3. Copy the configuration file and hive index files from Windows to the StarTeam 2009 Server for Linux
installation folder.
4. Copy the vault, including the attachments, from the Windows server to the Linux Server.
5. Install the Oracle client on the Linux machine.
Verify that the supported Oracle client versions for this release are installed.
6. Create a StarTeam user account on the Linux machine.
7. Establish Oracle connectivity between the Linux machine and the Oracle database currently used for storing
StarTeam metadata.
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8. Verify the database connectivity using SQL*Plus.
9. Open the Server Tools, and choose Help > About > License to verify that the Server is licensed correctly.
10. Select the configuration, and choose Server > Configuration from the menu.
11. On the General tab, set the correct log file path.
12. Select the Database Connection Information tab, and click Verify Connection to verify the database
connectivity.
13. Choose Tools > Administration > Hive Manager from Server Administration to update the hives.
If there are multiple hives, ensure that all of them are set correctly.
14. Choose Help > About > Info from Server Administration to verify that the destination build number is greater
than or equal to the source build on Windows. If the destination build number is greater than the source
build number, choose Actions > Upgrade.
This step upgrades the source database to the destination's build. Upgrade is not required when the source
and destination builds are identical.
15. Verify that the upgrade log that gets created in the log file path directory is error free.
16. Back up the current Oracle database.
Save this backup copy; do not recycle it.
17. Verify the upgrade process by starting the server with an Override and browsing to the Attachments path
to reset the Attachments directory.
Verify that the attachments from Windows are copied over to the Attachments directory.
18. Verify that the server log that gets created in the log file path directory is clean.

Assumed Knowledge
Before installing and configuring StarTeam Server and StarTeamMPX Server components for Linux, the
StarTeam administrator must be familiar with the following concepts and procedures:
•
•
•

Creating and modifying relational databases
Working with the features of their operating system, such as creating files, running executables, and
managing access rights
Basic configuration management concepts

For more information about installing StarTeamMPX on Linux, see Installing StarTeamMPX on Linux on page
62.

System Requirements and Prerequisites
•

Red Hat Enterprise Linux 5
Note: Advanced platform storage, virtualization, and high availability features (Red Hat Global File
System & Cluster Suite) are not supported.

•

Oracle Client 10g Release 2 (10.02.00.04) for Linux x86
Note: The Oracle database does not have to reside on the same machine as the StarTeam Server.

•
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Pre-Installation Setup
This section provides information about pre-installation setup considerations for running StarTeam Server on
Linux.

Environment Variables
Prior to installing StarTeam Server or StarTeam Server components, set the following environment variables:
•
•
•
•

JAVA_HOME environment variable to point to JRE or JDK 1.6.0_13 or above
NLS_LANG=AMERICAN_AMERICA.WE8MSWIN1252
ORACLE_HOME to point to Oracle home directory
PATH=$ORACLE_HOME/bin:$JAVA_HOME/bin:$PATH:

Permissions
Run the following command as root to make the StarTeam Server user account a member of the Oracle group
used to install the Oracle client:
/usr/sbin/usermod -a -G oinstall starteam_user_name
where oinstall is the default Oracle group name and starteam_user_name is the StarTeam Server user
account.

Installing StarTeam Server on Linux
1. Close all other applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the binary file using the command ./server.bin.
Note: When installing or uninstalling on a non-Windows platform, specify the installed Java VM to use
as a parameter when running the installer. This step is necessary because Java VMs for non-Windows
operating systems are not bundled with the installers. If you experience any difficulties running the
./server.bin command, add the parameter LAX_VM and specify the path to your VM. For example:
./server.bin LAX_VM /usr/java/latest/jre/bin/java.
4. In the StarTeam Server splash screen, select the appropriate language and click OK.
5. In the Introduction dialog box, read the information and click Next.
6. If the ORACLE_HOME variable is not set in your environment, the Get Oracle Path dialog box will appear.
Browse to or type the path to the Oracle client installation and click Next.
7. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
8. In the Choose Install Set dialog box, select Typical, Compact, or Custom.
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•
•
•

Typical -- Installs StarTeam Server with the StarDraw sample server configuration and the StarTeam
online documentation in PDF format.
Compact -- Installs StarTeam Server with the minimum required options. Select this option if you do
not want to install the StarDraw sample server configuration.
Custom -- Enables you to choose the options you want to install. Recommended for advanced users.

9. Click Next.
10. For a custom installation only, the Choose Install Set dialog box will appear. Select (to install) or clear (to
bypass) the check boxes for the available options.
•
•

StarTeam Server -- If you use the custom installation to install something that was not installed during
a previous installation of StarTeam Server, you may choose to clear this check box.
Sample server configuration -- Clear this check box if you do not want to install the StarDraw sample
server configuration.

11. Click Next.
12. In the Choose Install Folder dialog box, click Choose... to browse to the installation folder (the default
location is /home/starteam/starteamserver2009).
13. Click Next.
14. Review the information in the Pre-Installation Summary dialog box and click Install.
15. In the Install Complete dialog box, click Done to quit the installer.

Server Administration
Use the Server Administration application to configure and manage each StarTeam Server.
To start the Server Administration application, use the ./serveradmin.sh command from the installation
directory. The shell script sets up the shared library path LD_LIBRARY_PATH before starting the Server
Administration application.

SELinux
If SELinux is enabled in your system, you might receive a message like the following one when you start either
the StarTeam Server or the Cache Agent, or when you invoke the starteamserver command line:
/root/starteamserver2008/libzlib.so: cannot restore segment prot after reloc: Permission denied
To avoid this problem, set the SELinux Enforcement mechanism to permissive.
If this approach is not an option for your organization, run the command chcon -t textrel_shlib_t
*.so from each of the following directories:
•
•
•

•

38

The StarTeam Server installation directory.
$ORACLE_HOME/lib.
jrexx/lib/i386/client, where jrexx is the java runtime environment (jre) used by the starteam
server installation. If the server installation was performed by a root user, jrexx is installed in the directory
/opt/Borland/. If the server installation was performed by a standard user, jrexx is installed in the
home directory of the user.
The StarTeam Cache Agent installation directory.
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StarDraw
Borland provides the sample database StarDraw with StarTeam Server. The StarTeam Server installation
procedure:
•
•

Creates the Samples directory and subdirectories under the installation directory and copies the sample
repository files into them.
Copies the Oracle export file stardraw.dat into the
install_dir/starteamserver2009/Samples/StarDraw_Repository/Database directory.

Restoring the StarDraw Database Backup File
To restore the StarDraw database backup file on the Oracle database machine:
1. If you have not already done so, create the following on the Oracle database machine:
•
•

A database instance that will host the StarDraw database. StarDraw can share the database instance
with other databases.
A tablespace named stardraw on this instance. Following is a sample create tablespace command:
Create tablespace stardraw datafile 'c:\stardraw.dbf' size 400m autoextend
on next 10k maxsize 32767m extent management local

2. If StarTeam 2009 Server for Linux is on a different machine than your Oracle database, copy the file
stardraw.dat to the database machine. Using SQLplus, create an Oracle virtual directory that points to
the location of stardraw.dat. For example:
•
Windows

•

SQL> create or replace directory test_dir as
'C:\stardraw_dir';
SQL> grant read,write on directory test_dir to public;

where stardraw_dir is the folder that contains the file stardraw.dat.
•
Unix
•

SQL> create or replace directory test_dir as
'install_dir/starteamserver2009/Samples/StarDraw_Repository/
Database';
SQL> grant read,write on directory test_dir to public;

3. Run the following command (logged in as your Oracle user if your Oracle database is on Linux):
impdp system/password directory=test_dir dumpfile=stardraw.dat
logfile=stardraw.log
where password is the password for the "system" Oracle schema user, and test_dir is the Oracle virtual
directory created in step 2.

Using the StarDraw Server Configuration
To use the StarDraw server configuration:
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1. Give all StarTeam Server users read-write access privileges to the Samples directory and its subdirectories.
2. Start the Server Administration application.
3. Select the StarDraw configuration and choose Server > Configuration Properties….
The StarDraw Properties dialog box appears.
4. In the TNS service name text box on the Database Connection Information tab, type the Oracle database
instance name that hosts the StarDraw sample database.
5. Click Verify Connection... to verify the database connection.
6. Click OK.
7. In the Servers tree view in the left pane, select the StarDraw configuration and choose Actions > Start
with Override.... Browse to the Attachments path.
The StarDraw server configuration starts.
Note: It may take the StarTeam Server several minutes to perform the startup tasks the first time a
server configuration starts.
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Installing StarTeam Clients
This chapter explains how to install the StarTeam Cross-Platform Client on Windows and other platforms.
To learn to use the StarTeam Cross-Platform Client, refer to the PDF document Administering and Using
StarTeam or the online help link to StarTeam Help, both of which are available from the StarTeam
Cross-Platform Client 2009 ➤ Documentation submenu.

About the StarTeam Clients
StarTeam 2009 provides these client types:
Client

Provided for...

StarTeam Cross-Platform Client

Microsoft Windows
Solaris
Linux
Other platforms
This chapter describes how to install the StarTeam
Cross-Platform Client on all of these systems.

StarTeam Web Client

All systems with Internet access.

System Requirements for the StarTeam Cross-Platform Client
The StarTeam Cross-Platform Client can be installed on Microsoft Windows systems and any system that
supports Sun Microsystems Java Virtual Machine 1.6.0_13. The Cross-Platform Client has been tested on the
following systems:
System Area

Requirement

Platforms (32-bit)

Windows XP Professional SP3
Windows Vista SP1
Solaris Sparc 10
Red Hat Enterprise Linux (WS) 5.1

Processor

32-bit dual core

RAM

2 GB minimum

Hard disk space

200 MB to install the application
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System Area

Requirement
Note: Sufficient disk space is required for your working
files. The amount will vary depending on your use of
the product.

Display

SVGA, high color mode, 1024x768
Recommended resolution: 1280x1024 or more

Before Installing a StarTeam Client
Before you install the StarTeam Cross-Platform Client, make sure your computer system meets the minimum
requirements. For more information, see System Requirements for the StarTeam Cross-Platform Client on
page 41
StarTeam 2009 supports compatibility between clients and servers which are either one release ahead or
behind one another. This support is provided for your convenience in implementing your upgrades to the latest
release. Some functionality may only be available in the latest release. You will achieve best performance by
upgrading your clients and servers to the same release.
While some flexibility in client-server release combinations is allowed, StarTeam servers do not support
connections from clients using an SDK older than StarTeam SDK 2006. This supported connection release
will change in subsequent releases.
Important: You must be a local administrator on the target computer to install StarTeam products.

Setting up Default Personal Options
The StarTeam installation program copies the starteam-client-default-options.xml (if it exists) to the
user_home\Application Data\Borland\StarTeam folder on each client workstation. It will overwrite
an existing file with that name in that location. This file will be used as a template for the new
starteam-client-options.xml file as each user starts the StarTeam Cross-Platform Client for the first
time.
This allows for the distribution of the initial starteam-client-default-options.xml file— although not
from the StarTeam Installation DVD.
To provide all users of the StarTeam Cross-Platform Client with the same initial set of personal options:
1. Perform a custom installation of StarTeam Server while selecting the Client Setup check box, so that the
disk image for StarTeam is installed in the Client Setup folder, a child folder of the StarTeam Server
installation folder.
2. Make sure that this folder is one that all team members can access.
3. Install the StarTeam Cross-Platform Client on only one computer.
4. Set the personal options. See the Administering and Using StarTeam manual for details.
5. Notice that you now have a file named starteam-client-options.xml in the user profile folder. On Windows
XP, this is in the C:\Documents and Settings\user\Application Data\Borland\StarTeam
folder.
6. Copy this file to the Client Setup folder.
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7. Rename this file starteam-client-default-options.xml.
8. Instruct users to install the StarTeam Cross-Platform Client.

Installing the StarTeam Cross-Platform Client
You can install the StarTeam Cross-Platform Client on Windows or other operating systems such as Solaris
and Linux systems.

Installing on Windows
To install the StarTeam Cross-Platform Client on Windows:
1. Close all running Windows applications.
2. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 4
DVD into your DVD drive. The StarTeam Launcher window should appear automatically.
If the installation menu does not appear automatically from inserting the DVD, display it by performing the
following steps:
1. From the Windows Start menu, select Start ➤ Run
2. At the command prompt, type:
x:\setup.exe
where x: is the drive letter of your DVD drive.
3. Press Enter. The StarTeam 2009 installation main menu opens.
3. On the StarTeam 2009 main menu, click Install Products.
4. Click Cross-Platform Client and follow the installation instructions on the screen.
1. For non-English versions, select a language from the drop-down list box, and then click OK.
2. In the Introduction dialog box, read the information, and click Next.
3. In the License Agreement dialog box:
a. Read the agreement.
b. If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c. Click Next.
4. In the Choose Install Set dialog box:
a. Select the Typical, Compact, or Custom button.
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•

•
•

Typical installs the StarTeam client, its user manuals, its online help, and the StarTeam Toolbar.
The toolbar stores logon information making it easier to log on. For details, see the Administering
and Using StarTeam manual.
Compact installs only the StarTeam client, its user manuals, and its online help.
Custom allows you to select what is installed. This is the only way to install the StarTeam
Administration tool to use on a client workstation. When installed as part of the client, you can do
only remote server administration. Click Next.

5. If you selected a Custom install set, select or clear the check boxes for the parts you do and do not want
to install. The custom options are:
•
•
•

Application
StarTeam Toolbar
Server Administration

6. In the Choose Install Folder dialog box, click Choose to browse for the location to be used as the
installation folder.The default location is C:\Program Files\Borland\StarTeam Cross-Platform
Client 2009.
7. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeam Cross-Platform Client 2009).
8. In the Pre-installation Summary dialog box, do one of the following:
•
•

Review the settings and click Install.
Review the settings and click Previous one or more times if you want to change the installation
options. Then return to the Pre-installation Summary dialog box and click Install.

9. In the Install Complete dialog box, click Done.
The StarTeam Cross-Platform Client is installed in the specified folder, and the
StarTeam_Cross-Platform_Client_2009_InstallLog.log file in that folder documents what
happened during the installation process.

Installing on Linux or Solaris
To install the StarTeam Cross-Platform Client on Linux or Solaris:
1. If installing from the DVD, please select the OS specific installation. If installing from a compressed package
please decompress the install package.
2. Run the StarTeamCP.bin file with the parameter LAX_VM to invoke the installer. For example,
./StarTeamCP.bin LAX_VM /LAX_VM /usr/java/latest/jre/bin/java.
Important: You must specify which VM to use when you installing on non-Windows operating systems
since the installers are Java based, and are not bundled with a VM. This also applies to StarTeam
Server, EventTransmitter, MPX and Cache Agent (for example, server.bin, ca.bin, mpxserver.bin, and
mpxservices.bin).
3. Follow the directions on your screen.
4. After installation, run the StarTeamCP executable located in the user_home_directory\StarTeam
CP_2009 folder, or use the shortcut with the same name located in the directory selected during installation.

44

| Installing StarTeam Clients

Installing on Other Platforms
To install the StarTeam Cross-Platform Client on other platforms, use the Universal installation:
1. Extract the universal *.tar.gz file to the desired location. This file is available for download from the
Borland web site.
2. Use the CD command to reach the installation's ./bin folder and run the setup script.This creates executable
scripts in the same directory. Start StarTeamCP by running the "starteam" script.

Automating Client Installations
A silent install allows you to do multiple client installations at one time. You can run the client installer in a
“silent” mode from the command line by adding the -i parameter to the command. Alternatively, you can point
to a text file called Installer.properties which includes the directive INSTALLER_UI=silent.
The Installer.properties file can also specify parameters to pass to the installer, such as the destination
client installation directory, the root directory for the SDK installation, which components to install, and whether
or not a restart is needed.

Performing a Silent Install
Note: It is important to install the StarTeam client using a user that is an administrator on the computer.
You can run the client installer in a “silent” mode using one of the following commands:
1. starteamcp.exe -i silent
Use default values for the destination directory, installation type, and so on.
2. starteamcp.exe -f (path to installer.properties)
Uses customized parameters specified in the installer.properties file.
Or
starteamcp.exe
Note: If the file installer.properties is placed in the same directory as the installer, the file must
include at least one line that is INSTALLER_UI=silent.
The following table provides other possible silent installation options.
Identifier

Description

USER_INSTALL_DIR=c:\\Program
Files\\Borland\\ StarTeam
Cross-Platform 2009

Client installation path.

ST_SDKROOT=c:\\Program Files\\Borland
RESTART_NEEDED=NO

SDK installation path. Turn off reboot upon installation.

USER_REQUESTED_RESTART=NO
CHOSEN_INSTALL_SET=Compact

Turn off reboot upon installation. Compact leaves off the
Toolbar and Admin component
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Important: Double backslashes are required in path specifications.

Additional Customizations
StarTeam Server list and personal option files may be included with the silent installations.
These files are located in the local settings of the currently logged on user (for example, C:\Documents and
Settings\user_ID\Application Data\Borland\StarTeam). Once these files contain the desired
values (use a StarTeam Client to add the servers and set the personal options), copy these files to the same
location as the Installer.properties file. Rename these files as shown in the table below.
Original File Name

Description

Installation File Name

starteamservers.xml

StarTeam Servers at a site

server

starteam-client-options.xml

StarTeam personal options

starteam-client-default-options.xml

The starteam-client-default-options.xml file will be copied to the User local home settings (for
example, C:\Documents and Settings\user_home\Application Data\Borland\StarTeam). If
the starteam-client-default-options.xml file is included, the installation will overwrite this file if it
already exists. This file will be used as a template for future new instances of the
starteam-client-options.xml file in the user specific local settings. Existing instances of
starteam-client-options.xml will not be affected.
The server file will be copied to the installation user’s local settings if the starteamservers.xml does not
already exist. The starteam-server.xml file will not be overwritten. This will only affect the server settings
of the user who was currently logged on to the computer when the installation occurred.

Uninstalling the Client on Windows
The StarTeam Cross-Platform Client uses InstallAnywhere for installing and uninstalling. If you encounter one
of the following Java VM errors when uninstalling this product on a Windows system (such as 2003 or XP Pro),
you may need to install JRE 1.6.0_13 or earlier from the Sun website.
Uninstall errors:
•
•

"Can't launch executable. Could not find a suitable Java Virtual machine on your system."
"Windows error 3 occurred while loading the Java VM."

Installing StarTeam Integrations
StarTeam integrations are not included on the StarTeam Installation DVDs. Instead, they are posted for
download on the Borland web site at:
http://www.borland.com/downloads/download_starteam_integrations.html
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Installing and Configuring the StarTeam Web
Server
The StarTeam Web Server provides Web Client access to one or more StarTeam servers through supported
browsers.
This chapter explains how to install the StarTeam Web Server and specify the StarTeam servers, item types,
projects, and views that will be available to Web Client users.

System Requirements
The following table shows the system requirements for the StarTeam Web Server and the StarTeam Web
Client.
System Area

Requirement

Web Server Platform

Microsoft Windows Server 2008 (64-bit)

Web Client Browser

•
•

Microsoft Internet Explorer 7
Firefox 3

Processor

64-bit quad core

RAM

8 GB minimum

Hard disk space

200 MB to install the application

Note: You cannot install a 64-bit Windows StarTeam component on a 32-bit Windows system. The installer
will return an error upon attempting to install the Java VM.

Performance and Scalability
A maximum of 200 active concurrent Web Client users can be supported on one instance of the Web Server.
If no more than 200 users are actively performing operations in the Web Client, the number of concurrent users
may be higher. To support more than 200 active concurrent users, put them on another instance of the Web
Server.
An instance of the Web Server can provide access to thirty or more StarTeam views. The number of views
supported is impacted by the size of the views and the amount of memory provided to the process. To increase
the amount of memory made available to the Web Server, see Changing the Memory Allocated to the Web
Server on page 51.
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Installing the StarTeam Web Server
The OS user must have local administrative privileges to install and run the StarTeam 2009 Web Server on
Windows Server 2008.
1. Close all running Windows applications.
2. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 2
DVD into your DVD drive. The StarTeam Launcher window should appear automatically.
If the installation menu does not appear automatically from inserting the DVD, display it by performing the
following steps:
1. From the Windows Start menu, select Start ➤ Run
2. At the command prompt, type:
x:\setup.exe
where x: is the drive letter of your DVD drive.
3. Press Enter. The StarTeam 2009 installation main menu opens.
3.
4.
5.
6.
7.

On the StarTeam 2009 main menu, click Install Products.
Click Web Client.
For non-English versions, select a language from the drop-down list box, and then click OK.
In the Introduction dialog box, read the information, and click Next.
In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.

8. In the Choose Install Folder dialog box, click Choose… to browse to the desired location for the installation
folder.
The default Installation location is C:\Program Files\Borland\StarTeam 2009 Web Server. The
following options are provided.
•
•

To change the default location, click Choose...
To restore the default location, click Restore Default Folder.

Click Next to continue.
9. In the Choose Shortcut Folder dialog box, specify where you would like to create product icons. The
default location is C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Borland
StarTeam\StarTeam 2009 Web Server.
Click Next.
10. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Pre-installation Summary dialog box and
click Next.
11. In the Install Complete dialog box, click Done.
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Logging on to the StarTeam Web Server
1. From the Windows Start Menu, choose Borland StarTeam ➤ StarTeam 2009 Web Server ➤ Start Web
Server.
The Tomcat Console opens and starts the Web Server.
2. Open a supported browser and enter the following URL in the address bar:
http://<server>:<port>/BorlandStarTeam/BorlandStarTeamAdmin.jsp.
The Web Server logon page opens.
3. When logging on for the first time, type Administrator in both the User name and Password fields.
4. Click OK.
The Administrator Panel page opens.

Changing the Web Server Administrator User Name and
Password
1. In the Administration Panel, type the new user name in the User name text box.
2. Type the new password in the Password text box and again in the Confirm Password text box.
3. Click Save.

Adding a StarTeam Server to the Web Server
The StarTeam 2009 Web Server can only connect to a StarTeam 2009 Server that supports MPX, and MPX
must be running.
Perform the following steps to add a StarTeam Server to the Available Servers folder tree and specify the
Server's item types, projects, and views that will be available to Web Client users.
1. Type a unique, easy-to-remember description in the Description text box. It is not case-sensitive and can
contain colons (:).
Note: This description is the name used in the Web Client.
2. Type the Server's computer name or IP address in the Address text box.
3. Type the endpoint (TCP/IP port number) associated with the protocol in the Port text box.
4. Type your Server User name and Password in the appropriate text boxes.
Note: The specified user must have administrative rights on the StarTeam Server.
5. Click Add Server to Selected Servers.
The StarTeam Server will be added to the Available Servers folder tree with its check box checked by
default, as only checked entries can be made available to Web Client users.
Note: Web Server Administrators can make a StarTeam Server unavailable to Web Client users by
unchecking its check box.
6. Under the Server's Available Types, check the item types to be made available to Web Client Users.
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7. Under the Server's Available Projects, check the StarTeam projects to be made available to Web Client
Users.
8. Under each project's Available Views, check the views to be made available to Web Client Users.
Tip: The number of available views will affect the amount of memory needed for the Web Server
process. If the Web Server is running out of memory, set the disable_sdk_sessions value to true
in the file <Install Directory>/apache-tomcat-5.5.27/
webapps/BorlandStarTeam/config/server.xml.This will enable the Web Server to start without
loading the available views, and you can then decrease the configuration size.
9. Click Save, click OK on the confirmation dialog box, then restart the Web Server.

Removing a StarTeam Server from the Web Server
1.
2.
3.
4.

In the Available Servers folder tree, highlight the Server you want to remove.
Click Remove Selected Server.
Click Save.
Click OK on the confirmation dialog box, then restart the Web Server.

Accessing the StarTeam Web Client
To access the StarTeam Web Client, open a supported browser and enter the following URL in the address
bar: http://<server>:<port>/BorlandStarTeam/BorlandStarTeam.jsp.
The Web Client Start page opens.

Setting Up the Web Server as a Windows Service
The following parameters can be changed in the file StarTeamService.bat before creating the Windows
Service.
•
•

--JvmMx - The maximum memory provided to the Web Server. The value should be specified in MB; the
default value is 4096.
--Startup - Determines if the Windows Service will start up automatically when the OS starts up, or
manually. The default value is auto and can be changed to manual.

To set up the StarTeam Web Server as an automatic Windows Service, run <Install
Directory>/apache-tomcat-5.5.27/bin/StarTeamService.bat.
To remove the StarTeam Web Server as a Windows Service, run <Install
Directory>/apache-tomcat-5.5.27/bin/service.bat remove.

Enabling SSL Using a Valid Certificate
You must have a valid certificate available in order to enable SSL.
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1. Edit the <Install Directory>/apache-tomcat-5.5.27/conf/server.xml file in the follow ways.
•

Comment out the following xml block to disable the standard http access.
<Connector port="8080" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" redirectPort="8443" acceptCount="100"
connectionTimeout="20000" disableUploadTimeout="true" />

•

Uncomment the following xml block to enable https access and add the attributes.
<Connector port="8443" maxHttpHeaderSize="8192"
maxThreads="150" minSpareThreads="25" maxSpareThreads="75"
enableLookups="false" disableUploadTimeout="true"
acceptCount="100" scheme="https" secure="true"
keystoreFile="<path to certificate>" and keystorePass="<password>"
clientAuth="false" sslProtocol="TLS" />

2. Start the Web Server and direct users to https://<hostname>:8443/BorlandStarTeam.

Changing the Session Timeout Value
The Session Timeout value is used to determine when a user's Web Client session becomes invalid due to
inactivity. When a session times out, the user must be reauthenticated in order to continue to use the session.
To change the default Session Timeout, the Administrator should perform the following steps.
1. Navigate to the file BorlandStarTeam.xml in the directory <Install
Directory>/apache-tomcat-5.5.27/conf/Catalina/localhost.
2. Change the maxInactiveInternal attribute. This value is read in seconds and defaults to 1800 seconds
(30 minutes).

Changing the Memory Allocated to the Web Server
The amount of memory the Web Server can consume while running directly affects the amount of StarTeam
views that can be supported on the Web Server. To increase the memory provided to the Web Server in order
to support larger StarTeam configurations, the Administrator should perform the following steps before starting
the Web Server.
1. Navigate to the file setenv.bat in the directory <Install Directory>/apache-tomcat-5.5.27/bin.
2. Increase the JAVA_OPTS=-Xmx value.

Setting the Log Output Level
The logging level that the Web Server uses when updating the log files in the directory
apache-tomcat-5.5.27/logs is specified in the file
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apache-tomcat-5.5.27/shared/classes/logging.properties. The following levels can be set in
the file.
•
•
•
•
•
•
•
•
•

OFF
SEVERE
WARNING
INFO (default)
CONFIG
FINE
FINER
FINEST
ALL

Running Apache Tomcat Native
The Web Server does not ship with the library tcnative-1.dll for running Apache Tomcat Native. Testing
of the Web Server on the supported platform did not show any benefit to running the Web Server with native
enabled. If you wish to run the Web Server with native enabled, the 64-bit library tcnative-1.dll can be
downloaded from the Apache Software Foundation Web site at http://tomcat.apache.org/. Place the file in the
directory <Install Directory>/apache-tomcat-5.5.27/shared/lib, and restart the Web Server
to pick up the change.
Note: When downloading the file tcnative-1.dll, please be sure to download the version of the file
that matches your 64-bit architecture (AMD64 or Intel IA64) and Internet Protocol (IPv4 or IPv6).

Specifying Web Client Embedded Item Details
The records in the Web Client Item Table display a subset of the item property values defined by the selected
filter. Embedded item details can be used to reveal item properties not shown in the Item Table.
The default embedded item details for each item type are as follows.
•
•
•
•
•

Task - Task Name, Notes
Requirement - Name, Description
CR - Synopsis, Description, Fix
File - Description
Topic - Title, Description
Note: Administrators can also create custom html details templates and place them in the directory
<Install Directory>/apache-tomcat-5.5.27/shared/BorlandStarTeam/config. If a custom
html details template is found for the current view and type, that template will be used to render the
embedded details. The html details template format supported by the Web Client is the same format
supported by the StarTeam Cross-Platform Client. Refer to the StarTeam Cross-Platform Client Help for
more information.
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Installing StarTeamMPX on Windows
This chapter provides a brief overview of StarTeamMPX and explains how to install each of the StarTeamMPX
components on supported Windows systems. StarTeamMPX Event Transmitter and Message Broker are
included with the StarTeam Enterprise package.You must license the StarTeam Enterprise Advantage package
to use StarTeamMPX File Transmitter and Cache Agent.
The StarTeamMPX Administrator’s Guide provides comprehensive information about StarTeamMPX including
it’s architecture, configuration, and usage.
Note: If you are reading these instructions in a non-English language, note that this product and what
appears on the screen during installation are not translated into non-English languages.

About StarTeamMPX
StarTeamMPX is a framework for publish/subscribe messaging that improves the performance of the clients
and extends the scalability of server configurations. It contains both common and application-specific components
that together provide advanced messaging capabilities.
With StarTeamMPX, changes to the server configuration’s repository are broadcast in an encrypted format to
StarTeam clients and StarTeam Cache Agents through a publish/subscribe channel. For example, the StarTeam
Event Transmitter broadcasts encrypted messages about changes to objects, such as change requests, and
the StarTeam File Transmitter broadcasts archive files.
Caching modules automatically capture events that a client subscribes to. This reduces the client’s need to
send refresh requests to the server and improves client response times for the user.
StarTeam Cache Agents can be installed and configured to cache files in a network-near location to speed up
check-out operations. They reduce the distance that the data travels at the time of the client check-out operation.
While StarTeam Cache Agents are StarTeamMPX clients that rely on messages and files transmitted by the
Event Transmitter and File Transmitter, they also serve other StarTeamMPX clients as they check out files.
The File Transmitter and StarTeam Cache Agent are available with StarTeam Enterprise Advantage licensing
packages only.

StarTeamMPX Components
Most of StarTeamMPX components described below are installed separately. The transmitters are included
in the StarTeam Server installation.
•

StarTeamMPX Transmitters - There are two types of transmitters: an Event Transmitter and a File
Transmitter.
•

Event Transmitter - The Event Transmitter receives events of interest to StarTeam clients. The Event
Transmitter formats the event information it receives into XML messages, encrypts them, and publishes
them to a Message Broker. Messages are assigned topics so that they can be distributed to clients
interested in the accompanying content (project/view, item type, event type, etc.). The Event Transmitter
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is installed on the same computer as StarTeam Server. It must have the same build number as the
server.
•

•

File Transmitter - The File Transmitter broadcasts file contents and cache objects to one or more
Remote Cache Agents by way of a Message Broker. Like the Event Transmitter, the File Transmitter is
installed on the same computer as StarTeam Server and have the same build number as the server.

StarTeamMPX Message Broker - The Message Broker is a publish/subscribe messaging engine that
broadcasts messages to subscriber components on a topic basis. It is a stand-alone process that can run
on a separate computer to off load network processing overhead in high-volume environments.The Message
Broker broadcasts messages to each of its recipients using TCP/IP messaging.
The Message Broker receives encrypted XML messages from the Event Transmitter or encrypted files from
the File Transmitter, and forwards them to the appropriate clients. Information is sent from a Message
Broker directly to clients that have subscribed to that Message Broker by way of a TCP/IP connection profile.

•

StarTeamMPX Cache Agent - Cache Agent adds persistent file caching. Each MPX-enabled server
configuration can have one Root Cache Agent. One or more Remote Cache Agents can be distributed
throughout the enterprise.
A Root Cache Agent operates directly on the server configuration’s vault and cache. A Root Cache Agent
handles requests forwarded from Remote Cache Agents for missing files and provides “catch-up” assistance
for Remote Caches after network or process outages.
Cache Agent-aware StarTeam clients can fetch files from any available Cache Agent. By using “network-near”
Cache Agents, clients can improve file check-out performance and reduce their demands on the StarTeam
Server. This frees server resources for additional tasks and users.

System Requirements for StarTeamMPX
StarTeam Server must be installed prior to installing StarTeamMPX. StarTeamMPX transmitters have the
same system requirements as the StarTeam Server because they are part of that component.

Supported Operating Systems
The following operating systems are supported for the Message Broker and Cache Agent components with
this release of StarTeamMPX:
•
•
•
•

Microsoft Windows Server 2003 SP2 (32-bit)
Microsoft Windows Server 2003 R2 SP2 (32-bit)
Microsoft Windows Server 2008 (64-bit)
Red Hat Enterprise Linux 5 Server (32-bit)
Note: You cannot install a 64-bit Windows StarTeam component on a 32-bit Windows system. The installer
will return an error upon attempting to install the Java VM.

Hardware Recommendations
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Number of Peak Users

Recommended Configuration

less than 100

32-bit, dual-core systems with 4GB of memory

100 - 200

32-bit, quad-core systems with 4-8GB of memory
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Number of Peak Users

Recommended Configuration

more than 200

64-bit, quad-core systems with 8-16GB of memory

For the Message Broker, the number of peak users is typically lower than the number of peak users connected
to the StarTeam server since multiple Message Brokers are used in medium-to-large deployments. The number
of peak users connected to a Cache Agent is significantly lower because Cache Agents are only used in short
bursts. As a result, less hardware resources are typically required to support the Message Broker and Cache
Agent compared to the StarTeam Server. Moreover, for a given geographic location, the Message Broker and
Cache Agent are typically deployed on the same machine.

StarTeamMPX Configurations
Where you install StarTeamMPX components depends on your user distribution, networks, and purposes.
See the StarTeamMPX Administrator’s Guide which is available on the Borland StarTeam ➤ StarTeam
Server 2009 ➤ Documentation menu for more information about configuring StarTeamMPX.

Installing StarTeamMPX Overview
StarTeamMPX Message Broker and Cache Agent are installed separately from StarTeam Server. Installation
instructions for each of these products is included in the following sections.
Important: You must specify which VM to use when you install StarTeamMPX Message Broker and
Cache Agent on non-Windows operating systems since the installers are Java based, and are not bundled
with a VM.
For example: ./mpxserver.bin LAX_VM /usr/java/latest/jre/bin/java
StarTeamMPX Event and File Transmitters are automatically installed with the StarTeam Server in case you
will use them at some point in time. The next section discusses generating transmitter XML files.
Note: The Event Transmitter is included with the standard Enterprise license. You must have a StarTeam
Enterprise Advantage license to use the File Transmitter.
Access the StarTeamMPX Setup program for Message Broker and Cache Agent from the StarTeam Installation
DVD. You must install StarTeam Server before you can install StarTeamMPX.
For more information about StarTeamMPX, see the StarTeamMPX Administrator’s Guide.

Generating Transmitter XML Files
When the transmitters are installed as part of a StarTeam Server installation, the transmitter template files
(MPXEventTransmitterTemplate.xml and MPXFileTransmitterTemplate.xml) are installed in the EventServices
folder, a subfolder of the server’s installation folder.
When existing configurations are in place at the time of the installation, a configuration-specific set of transmitter
XML files is created automatically for each existing configuration. The configuration-specific XML files
(MPXEventTransmitter.xml and MPXFileTransmitter.xml) are created by copying the XML template
files to a configuration-specific subfolder of the EventServices folder. For example, the StarDraw sample server
configuration’s existence results in a subfolder of the EventServices folder named StarDraw.
When a new configuration is defined, a set of configuration-specific XML files may be generated automatically
depending on how the configuration is created:
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•

•

If you create a new configuration by using the Server Administration tool, a configuration-specific
MPXEventTransmitter.xml and FileTransmitter.xml will be created automatically. The utility does this by
copying the current XML template files to the appropriate configuration-specific subfolder of the EventServices
folder and removing “Template” from their names.
If you create a new configuration by using StarTeam Server’s command-line interface, no
configuration-specific XML files are created. If you want the new configuration to be MPX-enabled, you
need to create the configuration-specific subfolder of the EventServices folder. The configuration subfolder’s
name must be the same as the configuration name. Then manually copy the XML template files to the
appropriate configuration-specific subfolder of the EventServices folder and remove “Template” from their
names. Edit the new XML files as needed.

See the section “Understanding Connection Profiles” in the StarTeamMPX Administrator’s Guide for more
information on configuration-specific and XML template files.

Installing the Message Broker
The Message Broker can be installed on the same computer where the StarTeam Server is installed, or it can
be installed on a different computer. At least one Message Broker must be installed in your environment to
provide messaging services for an MPX-enabled StarTeam Server. As described in Understanding Clouds in
the StarTeamMPX Administrator’s Guide, you may want to install more than one Message Broker to meet your
needs.
Note: Note that the Setup program assumes the Message Broker will use the default port number 5101.
If you want to use a different endpoint, edit the file STMessageBroker68.ini after the setup program
completes. For more information, see Changing the Endpoint of a Message Broker in the StarTeamMPX
Administrator’s Guide.
To install the Message Broker on Windows:
1. On the computer where you wish to install the Message Broker, log on as the administrator or as a user
with administrative privileges.
2. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 1
(32 bit) or 2 (64 bit) DVD into your DVD drive. The StarTeam Launcher window should appear automatically.
If the installation menu does not appear automatically from inserting the DVD, display it by performing the
following steps:
1. From the Windows Start menu, select Start ➤ Run
2. At the command prompt, type:
x:\setup.exe
where x: is the drive letter of your DVD drive.
3. Press Enter. The StarTeam 2009 installation main menu opens.
3. In the Introduction dialog box, read the information, and click Next.
4. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the License Agreement, select I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
5. In the Service Start Options dialog box, select the appropriate radio button to specify whether you want to
install the Message Broker as an automatic or a manual service, and click Next.
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6. In the Choose Install Folder dialog box, click Choose… to browse to the desired location for the installation
folder.
The default Installation location is C:\Program Files\Borland\Message Broker 6.8. The following
options are provided.
•
•

To change the default location, click Choose...
To restore the default location, click Restore Default Folder.

Click Next to continue.
7. In the Choose Shortcut Folder dialog box, specify where you would like to create product icons. The
default location is C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeamMPX Message Broker 6.8.
Click Next.
8. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Pre-installation Summary dialog box and
click Next.
9. In the Install Complete dialog box, click Done.
10. Follow the instructions on the screen.
Because the Message Broker is installed as a service, you can choose whether to install it as an automatic
or manual service.

Upgrading the Message Broker
Multiple releases of Message Broker can run on the same machine if each uses its own port. You cannot start
both the 6.7 and 6.8 Message Brokers at the same time if they are on the same machine and listening on the
same port. Doing so causes a race condition, and the second one to start will fail.
If you installed a Message Broker from the StarTeam 2006 or 2008 release, you have Message Broker 6.7.
The Message Broker that ships with StarTeam versions 2008 Release 2 or 2009 is Message Broker 6.8. All
Message Broker versions are interoperable; consequently, you can upgrade them one at a time.
To upgrade to Message Broker 6.8, we recommend the following procedure:
1. Install Message Broker 6.8 on the same machine as Message Broker 6.7, letting the installer set it up as
an auto-start service.
2. If you have customized the file STMessageBroker67.ini, copy it to the Message Broker 6.8 installation
folder with the new name (STMessageBroker68.ini) so that you can reuse that file with Message Broker
6.8.
3. Stop Message Broker 6.7, and set the corresponding service (StarTeam Message Broker 6.7) to Manual
so it does not automatically start again.
4. Start Message Broker 6.8.
5. Determine that everything is working as expected, and then uninstall Message Broker 6.7.

Installing a Cache Agent
The following sections cover upgrade issues, pre-installation issues, and explain how to install a Cache Agent.
You need to install Cache Agent only once on any computer that will use one or more Cache Agents. You run
as many instances of Cache Agent as you need, each with a different and appropriate XML file.
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The default XML file for a Root Cache Agent is RootCAConfig.xml. The default XML file for a Remote Cache
Agent is RemoteCAConfig.xml. As you install Cache Agent, you also set up an initial Cache Agent
configuration file, so you must select either a Root or Remote Cache Agent during the installation. This does
not stop you from creating another configuration file for the same or a different type of Cache Agent later on
that same computer.

Upgrading a StarTeam Cache Agent
The StarTeam Cache Agent (Cache Agent) can be installed on a machine with a previous release.
Note: The goal is to transition StarTeam server configurations from the older to the newer release.
The Cache Agent can be run as either an application or a service.You can run multiple Cache Agent instances
on the same machine, but each needs its own configuration file.
By default, the installation creates a manual Cache Agent service for your convenience. If the installation
detects that a Cache Agent service already exists (for example, from a previous release), the installation notifies
you about that fact and does not set up a service.
•

If at least one Cache Agent service already exists (for example,
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\CacheAgentService already exists),
a new Cache Agent service is *not* created. Instead, the installer displays a warning message that an older
Cache Agent service was detected and a new Cache Agent service is not created. The warning advises
you to:
•

•

•

•
•

If the existing Cache Agent service is no longer needed, uninstall the previous Cache Agent release or
use the previous release to run "CacheAgentService ‘-unregister" from a console window to unregister
the existing Cache Agent. Note that this is optional—the older release can remain, including the services
created for it.
Create an appropriate configuration file for each Cache Agent service desired for the release just installed.
You can reuse configuration files from the previous release of Cache Agent by copying them to the new
location. You might need to rename them for use with multiple Cache Agent instances.
Using the release just installed, run "CacheAgentService - register" from a console window for each
Cache Agent service desired. Note that the "-name" parameter is used to define a unique service name
for each new service created.

If an older Cache Agent is installed but a Cache Agent service is not currently registered, the installer
creates a new service just as if the previous release was not there.
If an older Cache Agent is installed, you are not asked whether you are installing a root or remote cache
agent and are not asked for any configuration information. The sample files
(SampleRemoteCacheAgentConfig.xml and SampleRootCacheAgentConfig.xml) are installed
(as always), but neither the RootCAConfig.xml nor the RemoteCAConfig.xml file is created.

See the StarTeamMPX Administrator’s Guide available on the Borland StarTeam ➤ StarTeam Server 2009
➤ Documentation menu for more information about configuring Cache Agents.

Before Installing a StarTeam Cache Agent
When installing a Cache Agent that will be used as a root Cache Agent, StarTeam Server must be installed
first. After you have installed StarTeam Server, you can install the other components in any order.
The following is a recommendation for installing StarTeamMPX components:
1. Install StarTeam Server. The Event and File Transmitters are installed automatically with StarTeam Server.
2. Install the StarTeam Message Broker. You can run multiple instances of the Message Broker.
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3. Install the Root Cache Agent. You need to install it only once per machine, even when that machine has
more than one server configuration. You run multiple instances to support multiple StarTeam Server
configurations. Each server configuration must have its own root cache agent instance.
4. Install the Remote Cache Agent. This is the same installer as the Root Cache Agent. You typically install
and run a single Message Broker on remote machines.
The Remote Cache Agents can use the same Message Broker as the Root Cache Agent, but multiple
Message Brokers are suggested for distributed teams, especially over distances. In practice, Remote Cache
Agents usually use remote Message Brokers.
Before you start a Root Cache Agent:
1. Start each server configuration that you will use with Cache Agent. Doing this causes the File Transmitter
to generate or upgrade a CacheJournal.dat file for each configuration.
2. (Optional) Modify the MaxJournalAge parameter’s value in the FileTransmitter.xml file to represent
the maximum number of days for which records will be kept within the Journal file. The pre-configured
value is 180 days. Note that the Journal file is “trimmed” of expired records (those whose age exceeds
the MaxJournalAge value) only when the Server application is started for the associated configuration.

Installing a Cache Agent
Whether a Cache Agent operates as a Root Cache Agent or a Remote Cache Agent is determined solely by
its configuration. The installation of the Cache Agent is similar in both cases except for consideration of the
computer on which to install it:
•

•

The Root Cache Agent requires access to the vault for the server configuration that it services. Consequently,
it can be installed on the same computer as the StarTeam Server. Alternatively, if it can be installed on a
separate computer to prevent the Root Cache Agent from competing for CPU or network I/O with the
corresponding server configuration. However, this requires it to access the vault files and the
CacheJournal.dat file by way of a shared network drive, so use this option only when a high-speed network
is in place.
Remote Cache Agents should be installed in each geographic location that can benefit from improved file
check-out performance. One approach is to install a Cache Agent in each network environment that local
users can access over a highspeed LAN. (For example: Install two Remote Cache Agents at headquarters,
one each for engineering and QA, a third Remote Cache Agent at the Chicago office, and a fourth at the
London office.) Another beneficial use of the Cache Agent is to install an instance on a computer dedicated
to a check-out intensive application such as a build utility. There is no limit on the number of Cache Agents
that can be installed throughout an enterprise. However, keep in mind that each Cache Agent requires
access to a Message Broker. For more information about clouds, see “Understanding Clouds” in the
StarTeamMPX Administrator’s Guide.

To install a Root Cache Agent or Remote Cache Agent:
1. On the computer where you wish to install the Cache Agent, log on as the administrator or as a user with
administrative privileges.
2. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 1
(32 bit) or 2 (64 bit) DVD into your DVD drive. The StarTeam Launcher window should appear automatically.
If the installation menu does not appear automatically from inserting the DVD, display it by performing the
following steps:
1. From the Windows Start menu, select Start ➤ Run
2. At the command prompt, type:
x:\setup.exe
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where x: is the drive letter of your DVD drive.
3. Press Enter. The StarTeam 2009 installation main menu opens.
3. Click Install Products.
4. Click Cache Agent. This selection lets you install either the Root Cache Agent or a Remote Cache Agent.
5. Follow the installation instructions on the screen:
1. For non-English versions, select a language from the drop-down list box, and then click OK.
2. In the Introduction dialog box, read the information, and then click Next.
3. In the License Agreement dialog box:
a. Read the agreement.
b. If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c. Click Next.
6. Choose an installation folder.The default installation path is C:\Program Files\Borland\StarTeamMPX
Cache Agent 2009.
7. Choose a Root Cache Agent or Remote Cache Agent installation.
8. For a Root Cache Agent installation, you are prompted to enter:
Message Broker Address: Enter the host name or address of the Message Broker that the Root Cache
Agent will use to communicate with other Cache Agents and clients. This value can optionally include the
protocol prefix (tcp:) and port number suffix (:1234). The port number must be provided if the Message
Broker is not using the default port of 5101. For example: tcp:MBServer1:5123
StarTeam Server Cache folder: Click Choose to browse to the folder path that contains the vault cache
of the server configuration that the Cache Agent will serve. This path must be relative to the computer on
which the Root Cache Agent is being installed.
9. For a Remote Cache Agent installation, you are prompted to enter:
Message Broker Address: Enter the host name or IP address of the Message Broker that the Remote
Cache Agent will use to receive file content messages and to communicate with other Cache Agents and
clients. A Remote Cache Agent should be configured to use a Message Broker and the tcp: address.
This option is described in more detail in “Configuring a Remote Cache Agent” in the in the StarTeamMPX
Administrator’s Guide.
10. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button set
to C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeamMPX Cache Agent 2009).
11. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Preinstallation Summary dialog box and
click Install.
12. In the Install Complete dialog box, click Done.

After Installing Cache Agent
Depending upon your environment, you may have to perform additional steps to use the Cache Agent:
For any Cache Agent:
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•
•

The Cache Agent installer installs both CacheAgentService.exe and CacheAgentApp.exe so you can run
Cache Agent as either a service or a console application.
CacheAgentService is configured as a “Manual” start service.You may want to change the start type to
“Auto” so that the Cache Agent will start automatically thereafter. To change the start type to “Auto”, use
the Control Panel Services interface or unregister and re-register the service. See “Running Cache Agent
on Windows” in the StarTeamMPX Administrator’s Guide for more information.

If you installed a Root Cache Agent:
•

The default configuration file for a Root Cache Agent is RootCAConfig.xml. It may need to some modification.
See “Configuring a Root Cache Agent” in the StarTeamMPX Administrator’s Guide.

If you installed a Remote Cache Agent:
•

The default configuration file for a Remote Cache Agent is RemoteCAConfig.xml. It needs some modification
for your environment. It is configured with a sample configuration file that “tiers” the Cache Agent to the
Root Cache Agent for the StarDraw sample configuration (even if it does not actually exist). See “Configuring
a Remote Cache Agent in the StarTeamMPX Administrator’s Guide.

Uninstalling MPX Components
Each time you install a StarTeamMPX component, an Uninstall program shortcut is created for that component.
The Uninstall programs enable you to remove the Message Broker and/or Cache Agents from your computer.
Your StarTeam Server installation, server configurations, and repositories are unaffected.
The uninstall program for the server leaves the transmitter template files and each configuration's transmitter
XML files intact. A subsequent installation will not overwrite these files.
The StarTeamMPX Services Uninstall programs leave the STMessageBroker68.ini file intact. If you later
reinstall these services, this file will not be replaced by the new installation.
Note: StarTeamMPX uses InstallAnywhere for installation and uninstallation. If you encounter one of the
following Java VM errors when uninstalling this product on a Windows system (such as 2003 or XP Pro),
you may need to install JRE 1.6.0_13 or earlier from the Sun website.
Uninstall errors:
•
•

"Can't launch executable. Could not find a suitable Java Virtual machine on your system."
"Windows error 3 occurred while loading the Java VM."
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Installing StarTeamMPX on Linux
This chapter explains how to install StarTeamMPX on Linux. For a brief overview about StarTeamMPX, see
Installing StarTeamMPX on Windows on page 53.

Installing StarTeam Message Broker on Linux
1. Close all other applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the binary file using the command ./mpxservices.bin.
Note: When installing or uninstalling on a non-Windows platform, specify the installed Java VM to use
as a parameter when running the installer. This step is necessary because Java VMs for non-Windows
operating systems are not bundled with the installers. If you experience any difficulties when running
the command ./mpxservices.bin, add the parameter LAX_VM and specify the path to your VM.
For example: ./mpxservices.bin LAX_VM /usr/java/latest/jre/bin/java.
Note: If the OpenSSL toolkit (openssl097a-0.9.7a-9.i386.rpm) and the Compatibility standard
C++ libraries (compat-libstdc++-33-3.2.3-61.i386.rpm) are not installed, the StarTeamMPX
Services installer will prompt you to install them before continuing with the installation of StarTeam
Message Broker.
4. In the Introduction dialog box, read the information and click Next.
5. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
6. In the Choose Install Folder dialog box, browse to or type the path to the installation folder (the default
location is /opt/messagebroker68).
7. Click Next.
8. In the Choose Link Folder dialog box, specify whether to create links in your home folder, to create them
in another location, or to not create them at all.
9. Click Next.
10. Review the information in the Pre-Installation Summary dialog box and click Install.
11. In the Install Complete dialog box, click Done to quit the installer.
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Installing a StarTeamMPX Root or Remote Cache Agent on
Linux
1. Close all other applications.
2. Navigate to the directory that contains the downloaded files.
3. Run the binary file using the command ./ca.bin.
Note: When installing or uninstalling on a non-Windows platform, specify the installed Java VM to use
as a parameter when running the installer. This step is necessary because Java VMs for non-Windows
operating systems are not bundled with the installers. If you experience any difficulties when running
the command ./ca.bin, add the parameter LAX_VM and specify the path to your VM. For example:
./ca.bin LAX_VM /usr/java/latest/jre/bin/java.
4. In the Introduction dialog box, read the information and click Next.
5. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
If you do not accept the license agreement, you cannot install the product.
c) Click Next.
6. In the Choose Install Folder dialog box, browse to or type the path to the installation folder (the default
location is /home/starteam/cacheagent2009).
7. Click Next.
8. In the Choose Cache Agent Type dialog box, select the Cache Agent type you wish to install and click
Next:
•

•

Root Cache Agent -- Each StarTeam configuration can have one Root Cache Agent. You can install
it on the same machine as StarTeam Server or on a separate machine that has access to the
configuration's vault cache folder.
Remote Cache Agent -- You can install any number of Remote Cache Agents throughout your
organization. Typically, one Remote Cache Agent must be installed in each geographic region. Each
Remote Cache Agent is usually chained or tiered to one or more Root Cache Agents.

9. If the Cache Agent type is Root, use the Get Root Cache Agent Settings dialog box to perform the following
steps:
1. Specify the address of the Message Broker to be used.
2. Browse to or type the path to the repository of the StarTeam server configuration. The default location
is /home/starteam/starteamserver2009/Samples/StarDraw_Repository/.
3. Click Next.
If the Cache Agent type is Remote, use the Get Remote Cache Agent Settings dialog box to perform the
following steps:
1. Specify the address of the Message Broker to be used.
2. Specify the StarTeam server configuration GUID.
3. Click Next.
10. In the Choose Link Folder dialog box, specify whether to create links in your home folder, to create them
in another location, or to not create them at all.
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11. Click Next.
12. Review the information in the Pre-Installation Summary dialog box and click Install.
13. In the Install Complete dialog box, click Done to quit the installer.
In order to start the Cache Agent, set the environment variable LD_LIBRARY_PATH to point to the lib folder
of the Oracle home directory.
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Installing StarTeam Layout Designer
This section explains how to install the StarTeam Layout Designer.
To learn to use the StarTeam Layout Designer, refer to the PDF document Administering and Using StarTeam
or the online help link to StarTeam Help, both of which are available from the StarTeam Cross-Platform
Client 2009 ➤ Documentation sub-menu.

About StarTeam Layout Designer
The StarTeam Layout Designer provides the ability to customize forms within the application. Custom forms
can be used to show custom properties, hide default properties that are not of interest to your organization,
or rearrange the interface to more closely meet your organization’s requirements.
For example, you can design a Change Request Properties dialog box that has custom fields on its first (or
perhaps only) tab. You usually install StarTeam Layout Designer on the workstations of administrators who
will design custom property editors.
Property editors designed with Layout Designer are usually used only with StarTeam Enterprise because they
cannot be used with the custom workflow rules created with StarTeam Workflow Designer which is provided
with StarTeam Enterprise Advantage.

System Requirements for the StarTeam Layout Designer:
Overview
The StarTeam Layout Designer can be installed on Microsoft Windows systems that support Sun Microsystems
Java Virtual Machine 1.6.0_13. The system requirements are listed below:
System Area

Requirement

Platforms (32-bit)

Windows XP Professional SP3
Windows Vista SP1
Red Hat Enterprise Linux Desktop (WS) 5.1

Processor

32-bit dual core

RAM

2 GB minimum

Hard disk space

200 MB to install the application
Note: Sufficient disk space is required for your working
files. The amount will vary depending on your use of
the product.

Display

SVGA, high color mode, 1024x768
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System Area

Requirement
Recommended resolution: 1280x1024 or more

Installing StarTeam Layout Designer
To install the StarTeam Layout Designer on Windows:
1. On the computer where you wish to install the StarTeam Layout Designer, log on as the administrator or
as a user with administrative privileges.
2. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 4
DVD into your DVD drive. The StarTeam Launcher window should appear automatically.
If the installation menu does not appear automatically from inserting the DVD, display it by performing the
following steps:
1. From the Windows Start menu, select Start ➤ Run
2. At the command prompt, type:
x:\setup.exe
where x: is the drive letter of your DVD drive.
3. Press Enter. The StarTeam 2009 installation main menu opens.
3.
4.
5.
6.

Click Install Products.
Click Administrative Tools.
Click StarTeam Layout Designer.
Follow the installation instructions on the screen:
1. For non-English versions, select a language from the drop-down list box, and then click OK.
2. In the Introduction dialog box, read the information, and then click Next.
3. In the License Agreement dialog box:
a. Read the agreement.
b. If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c. Click Next.
4. Choose an installation folder.The default installation path is C:\Program Files\Borland\StarTeam
Layout Designer.
5. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeam Layout Designer).
6. In the Pre-installation Summary dialog box, review the settings. If you want to make changes, click
Previous one or more times so that you can change the installation options. Then return to the
Pre-installation Summary dialog box and click Install.
7. In the Install Complete dialog box, click Done.
The StarTeam Layout Designer is installed in the specified folder.
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Installing StarTeam Workflow Extensions
This chapter explains how to install the following StarTeam Workflow Extensions components:
•
•
•

StarTeam Extensions
StarTeam Workflow Designer
Borland StarTeam Notification Agent

See the StarTeam Extensions User’s Guide for complete information about how to configure and use these
Workflow Extensions.
Note: If you are reading these instructions in a non-English language, note that this product and what
appears on the screen during installation are not translated into non-English languages.

About StarTeam Workflow Extensions
Workflow is a comprehensive term to explain a process by which members of an organization complete complex
tasks. Whether your organization uses formalized or ad hoc workflows, there is a process or pattern by which
work is accomplished. StarTeam Workflow Extensions automates workflows by providing automatic notification
of responsibility, by presenting only appropriate options at each step in the process, and by assuring that items
are acted upon in a timely manner.
The StarTeam Workflow Extensions are a collection of .jar and other files that are updated more frequently
than the regularly scheduled application releases. However, customizing the application to meet your workflow
needs requires other features, some of which are installed as part of the Server and Client applications, and
others that come with the product but must be installed separately at locations that meet your needs.
The products, tools, and features StarTeam Workflow Extensions provides to set up and maintain workflow
processes are described in the following sections.

About StarTeam Extensions
StarTeam Extensions includes:
•

•
•
•

Alternate Property Editors (APEs) and the Java beans that make them easy to create. APEs, which are
forms written in a standard programming language such as Java, replace the standard properties dialog
boxes that come with each component of the application.
A workflow engine that reads the appropriate .Workflow.xml file and populates the APEs.
A toolbar that can be used with the Cross-Platform Client to start applications that add new features to the
application.
Various other utilities and libraries written in Java.

StarTeam Extensions files are released with the Application Server as part of each new release or service
pack. There are also interim releases of StarTeam Extensions. In either case, you separately install the runtime
files, documentation, and samples.
The default installation folder is C:\Program Files\Borland\StarFlow Extensions, but Borland
recommends copying these files to a different folder for each server configuration that runs on the same Server.
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For example, you might use C:\config_name\StarFlow Extensions. In this way, you can ensure that
each configuration’s StarFlow Extensions project has different working folders.
Even if you currently run only one server configuration, it is wise to plan ahead. This also ensures that, when
you upgrade or reinstall for some other reason, you are unlikely to overwrite any StarTeam Extensions files
that you are using.
See the section, “Using StarTeam Extensions” in the StarTeamMPX Administrator’s Guide.

About StarTeam Workflow Designer
Workflow Designer outputs .xml files that formalize the steps in a workflow, specifies who will be notified about
each step and about exceptions, and so on. Each file is named item_type.Workflow.xml and can be used
for an entire project or individual views within that project. The StarTeam Extensions workflow engine and
Notification Agent read from these files.
You must use Workflow Designer to develop custom workflows. The resulting .Workflow.xml file can be
deployed in StarTeam installations as long as the most recent version of StarTeam Extensions is also installed.
Workflows written using the releases of the Workflow Designer prior to version 5.2 (which were tightly coupled
to Microsoft Outlook) must be re-saved using the new Workflow Designer only if you plan to use Notification
Agent or if you want to make changes to the workflow.
Workflow Designer can be installed separately on any workstation that has a Cross-Platform Client.
With the help of Borland consultants, it can be installed on the customer toolbar that can be used with the
Cross-Platform Client.

About StarTeam Notification Agent
StarTeam Notification Agent monitors server configurations to determine who needs to be notified about work
to be performed and about exceptions that occur in the workflow process.
It must be installed and set up separately. It is usually installed on the computer that runs the Server, but it
can be installed anywhere. When StarTeam Notification Agent is not on the same computer as the StarTeam
Server, the two computers’ clocks must be synchronized. The StarTeam Notification Agent’s time cannot be
ahead of StarTeam Server’s time.

System Requirements for StarTeam Workflow Extensions
StarTeam Extensions and StarTeam Workflow Designer have the same system requirements as the StarTeam
Cross-Platform Client. For more information, see System Requirements for the StarTeam Cross-Platform
Client on page 41.
StarTeam Notification Agent has the same system requirements as StarTeam Server. For more information,
see System Requirements for StarTeam Server on page 17.
It is good practice to install StarTeam Server 2009 prior to installing StarTeam Notification Agent.

StarTeam Extensions Installation Strategies
StarTeam Extensions can be installed in segments. You can install the runtime files, documentation, and
samples where they are most needed or easiest to work with.
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The default installation folder is C:\Program Files\Borland\StarFlow Extensions, but Borland
recommends copying the runtime files to a different folder for each server configuration. For example, you
might use C:\config_name\StarFlow Extensions. In this way, you can ensure that each configuration’s
StarFlow Extensions project has different working folders.
After installing Extensions Runtime:
•
•
•

Copy the StarFlow Extensions folder and its subfolders (Client, Projects, and Utilities) to a unique location
for each server configuration.
Use the StarFlow Extensions folder (in its new location) to create a project named StarFlow Extensions in
each server configuration.
Add the files in these folders to the StarFlow Extensions project—except for the extensions.pdf, install_en.pdf,
and the readme_en.html files in the StarFlow Extensions folder.
If you are already using StarTeam Extensions, check in these files as new revisions of existing files and
add any new files.

Files from StarTeam Extensions need to be installed and then checked in to the StarFlow Extensions project
in each server configuration that uses alternate property editors (APEs) and workflows. If the StarTeam server
configuration does not already have a StarFlow Extensions project, you need to add one and all users need
to have read access to the files in it. Administrators can have read/write access.
Even if you currently run only one server configuration, it is wise to plan ahead. This also ensures that, when
you upgrade or reinstall for some other reason, you are unlikely to overwrite any files in the StarFlow Extensions
project that you have modified on your workstation and have not checked in.
Caution: If you are using the default installation folder for any server configuration’s StarFlow Extensions
project, Borland recommends that you check in everything you need that is not current prior to reinstalling
or upgrading StarTeam Extension files.

Installing StarTeam Extensions
The menu mentioned in the following installation procedure is for Windows installations. For non-Windows
platforms, use the files Extensions-2009-LINUX.tar.gz or Extensions-2009-Universal.tar.gzon
the DVD.
To install the StarTeam Extensions:
1. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 4
DVD into your DVD drive.
The StarTeam Launcher window should appear automatically. If the installation menu does not appear
automatically from inserting the DVD, perform the following steps:
a) From the Windows Start menu, select Start ➤ Run
b) At the command prompt, type: x:\setup.exe, where x: is the drive letter of your DVD drive.
c) Press Enter.
The StarTeam 2009 installation main menu opens.
2. Click StarTeam Extensions.
3. In the Introduction dialog box, read the information, and click Next.
4. In the License Agreement dialog box:
a) Read the agreement.
b) If you agree with the license agreement, click I accept...
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If you do not accept the license agreement, you cannot install the product.
c) Click Next.
5. In the Choose Install Folder dialog box, click Choose… to browse to the desired location for the installation
folder.
The default Installation location is C:\Program Files\Borland\StarFlow Extensions.The following
options are provided.
•
•

To change the default location, click Choose...
To restore the default location, click Restore Default Folder.

Click Next to continue.
6. In the Choose Install Set dialog box, uncheck or leave checked the following options:
•

Runtime - Installs the files that are critical to each server configuration that uses workflow, APE forms,
and/or custom tools. The Runtime should be installed on the same computer as the Server.
The Runtime consists of the StarFlow Extensions folder and two subfolders:
•

The Client folder contains the files that are normally installed with one or more of the clients as well
as with StarTeam Extensions. These files have changed very little since initially released. However,
if a user is having problems with an APE, give that user the latest files from the Client folder in the
StarFlow Extensions project. It may solve the problem.
starteam-extensions.jar provides the Locator functionality (the retrieving of workflow and APE files)
in conjunction with Locator.exe. The starteamextensions. jar file is installed with both the
Cross-Platform Client and the Visual Studio integration. The Locator files are installed only with the
Visual Studio integration.

•

The Projects folder contains a variety of .jar, .xml, and .dll files used by StarTeam Extensions.

Although the Runtime includes the custom toolbar that can be used with the Cross-Platform Client, if
you will be writing applications for the toolbar or adding buttons to the toolbar, you should seek assistance
from Borland consultants.
•

Samples - Adds the Samples subfolder to the StarFlow Extensions folder.
The Samples can be installed on any computer for your convenience. You do not need to copy these
to each server configuration’s StarFlow Extensions folder, nor do you need to check them in.
If you decide to use some of the sample APE forms, as they are or after some modification, you would
copy the item_type.Workflow.xml, name.propertyeditor.xml, and name.jar files to a server configuration’s
StarFlow Extensions\Projects folder or an appropriate subfolder of the Projects folder. Then you would
check these files in to the StarFlow Extensions project.
If you decide to use some of the sample tools, as they are or after some modification, you must also
copy the name.tool.xml and the name.jar files to the Projects folder. See the StarTeam Extensions
User’s Guide for more information.

•

API Documentation - Adds the Documentation subfolder to the StarFlow Extensions folder.
The Documentation can be installed on any computer for your convenience. You do not need to copy
this folder to each server configuration’s StarFlow Extensions folder, nor do you need to check its files
in. These online documents (.html files) explain the APIs for the APEs and the custom toolbar.
This folder does not include the readme file or the StarTeam Extensions User’s Guide. They are installed
in the StarFlow Extensions folder.

Click Next.
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7. In the Choose Shortcut Folder dialog box, specify where you would like to create product icons. The
default location is C:\Documents and Settings\All Users\Start Menu\Programs\Borland
StarTeam\StarTeam Extensions.
Click Next.
8. In the Pre-installation Summary dialog box, review the settings and click Previous one or more times if
you want to change the installation options. Then return to the Pre-installation Summary dialog box and
click Install.
9. In the Install Complete dialog box, click Done.

Installing StarTeam Workflow Designer
You must use Workflow Designer to develop custom workflows. Workflow Designer outputs .xml files that
formalize the steps in a workflow, specifies who will be notified about each step and about exceptions, and so
on. Each file is named item_type.Workflow.xml and can be used for an entire project or individual views within
that project. The StarTeam Extensions workflow engine and Notification Agent read from these files.
Workflow Designer can be installed separately on any workstation. With the help of Professional Services, it
can be added to the custom toolbar that can be used with the Cross-Platform Client.
To install StarTeam Workflow Designer:
1. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 4
DVD into your DVD drive. The StarTeam Launcher window should appear automatically.
If the installation menu does not appear automatically from inserting the DVD, display it by performing the
following steps:
1. From the Windows Start menu, select Start ➤ Run
2. At the command prompt, type:
x:\setup.exe
where x: is the drive letter of your DVD drive.
3. Press Enter. The StarTeam 2009 installation main menu opens.
2. Click Install Products.
3. Click Administrative Tools.
4. Select StarTeam Workflow Designer and follow the directions on the screen.
1. In the Introduction dialog box, read the information, and click Next.
2. In the License Agreement dialog box:
a. Read the agreement.
b. If you agree with the license agreement, click I accept.... If you do not accept the license agreement,
you cannot install the product.
c. Click Next.
3. In the Choose Install Folder dialog box, click Choose to browse for the location to be used as the
installation folder. The default is C:\Program Files\Borland\StarTeam Workflow Designer.
4. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\ Programs\Borland StarTeam\StarTeam Workflow
Designer).
5. In the Pre-installation Summary dialog box, do one of the following:
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•
•

Review the settings and click Install.
Review the settings and click Previous one or more times if you want to change the installation
options. Then return to the Pre-installation Summary dialog box and click Install.

6. When you see the Install Complete screen, read the message to be sure that the installation was
successful, then click Done.

Installing StarTeam Notification Agent
Notification Agent monitors server configurations to determine who needs to be notified about work to be
performed and about exceptions that occur in the workflow process.
You must install and configure Notification Agent separately. It is usually installed on the computer that runs
the Windows version of the StarTeam Server, but can be installed anywhere. When Notification Agent is not
on the same computer as the Server, the two computers clocks must be synchronized. Notification Agent’s
time cannot be ahead of the Server’s time. When both are installed on the same computer and run as services,
Notification Agent must be run as a dependent service and be shut down first. See “Running Notification Agent
as a Service” in the StarTeam Workflow Extensions User’s Guide for more information.
To install the StarTeam Notification Agent:
1. Run the downloaded installer, or if using replacement DVDs, insert the StarTeam 2009 Installation Disk 3
DVD into your DVD drive. The StarTeam Launcher window should appear automatically.
If the installation menu does not appear automatically from inserting the DVD, display it by performing the
following steps:
1. From the Windows Start menu, select Start ➤ Run
2. At the command prompt, type:
x:\setup.exe
where x: is the drive letter of your DVD drive.
3. Press Enter. The StarTeam 2009 installation main menu opens.
2. Click Install Products.
3. Click Administrative Tools.
4. Select StarTeam Notification Agent and follow the directions on the screen.
1. In the Introduction dialog box, read the information, and click Next.
2. In the License Agreement dialog box:
a. Read the agreement.
b. If you agree with the license agreement, clickI accept.... If you do not accept the license agreement,
you cannot install the product.
c. Click Next.
3. In the Choose Install Folder dialog box, click Choose to browse for the location to be used as the
installation folder. The default is C:\Program Files\Borland\StarTeam Notification Agent.
4. In the Choose Shortcut Folder dialog box, use the default setting (that is, keep the Other option button
set to C:\Documents and Settings\All Users\Start Menu\ Programs\Borland StarTeam\StarTeam
Notification Agent).
5. In the Pre-installation Summary dialog box, do one of the following:
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•
•

Review the settings and click Install.
Review the settings and click Previous one or more times if you want to change the installation
options. Then return to the Pre-installation Summary dialog box and click Install.

6. When you see the Install Complete screen, read the message to be sure that the installation was
successful, then click Done.
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Using StarTeam with Microsoft SQL Server
and SQL Server Express Databases
This chapter explains how to create a new server configuration to use Microsoft SQL Server or SQL Server
Express databases with StarTeam Server. StarTeam Server stores everything except for file archives and
server startup information in the database of your choice.
You can use the Windows version of StarTeam Server with the following Microsoft databases:
•
•

Microsoft SQL Server 2005 Express (SSE 2005), installed for you by StarTeam Server 2009.
Microsoft SQL Server 2005 R2

Microsoft SQL Server 2005 Express is the StarTeam default database. We advise users to read the SQL
Server Express license agreement provided by Microsoft Corporation.
StarTeam Server completely automates the process of creating SQL Server and SQL Server Express databases
for use with StarTeam server configurations. However, if you prefer, you can create your own database. See
Creating a Database Manually: Overview on page 83 for more information.
This chapter also provides an overview of the tuning and maintenance SQL scripts that are provided with
StarTeam Server and explains how to use them. For detailed information on Microsoft SQL Server performance
tuning, consult your Microsoft SQL Server documentation.

Terminology for Microsoft Databases
This chapter uses Microsoft terminology for the terms instance and database. When you install Microsoft SQL
Server 2005 on a computer, you can install up to 16 instances of it. Each instance can manage a number of
different databases. Each StarTeam server configuration uses its own database.
When you perform a typical installation of StarTeam Server, you install one instance of SQL Server Express.
More instances come in the download package at the web site and are included on the StarTeam installation
DVD because SQL Server Express instances are numbered. This is because you may already have SQL
Server Express on the computer, and StarTeam must use a different number than any instance that you already
have.

Logging Onto Databases
It is highly recommended that you use a dedicated StarTeam user account to run or log onto the databases
used with StarTeam server configurations. System administrator accounts usually have unlimited privileges.
Any anomalies or errors that occur while you are logged in as the system administrator may result in
unrecoverable damage to StarTeam databases and other databases managed by the same database server.
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Understanding the Encoding Differences
StarTeam Server sends data encoded as UTF-8. Microsoft SQL Server and SQL Server Express do not support
UTF-8 at the database level. They support nchar, nvarchar, and ntext to store fixed format Unicode data
(UTF-16).
•
•

UTF-8 is a variable length character set in which the characters can expand from one to six bytes depending
on the language.
UTF-16 is a fixed length encoding mechanism in which every character expands to two bytes. UTF-16
tends to use up more space than UTF-8 when applied to character sets in which one character always
translates to one byte.

Because of the way StarTeam encodes data, non-English StarTeam data is human-readable from StarTeam
clients, but not from Microsoft SQL Server and SQL Server Express.
This is also why it is critical that the ODBC drivers used by the Microsoft SQL Server and SQL Server Express
databases do no translation of the data. When StarTeam Server creates a DSN to be used with a server
configuration’s database, it turns off the ODBC autotranslation feature. Similarly, if you create your own
database, you must manually turn off the autotranslation feature. The SQL Server ODBC Data Source Test
for the Microsoft ODBC driver will fail because this feature is turned off, but that is correct behavior for DSNs
created for use with StarTeam server configurations.

Overview of Using a Microsoft SQL Server Database
If you will be using a Microsoft SQL Server database, you must complete the following tasks:
1. Install Microsoft SQL Server.
Important: When you install a Microsoft SQL Server database instance, it defaults to the collation for
the locale set for the operating system. This locale setting should be used so long as it is correct for
your team. Otherwise, when you automatically create a database from StarTeam Server, you cannot
provide a database name, user name, or password in your language.
2. Install StarTeam Server. For more information, see Installing StarTeam Server on page 26.
3. Create and start a StarTeam server configuration.
•
•

If you want StarTeam to automatically create the database, see Creating and Starting a Server
Configuration on page 76.
Otherwise, see Creating a Database Manually: Overview on page 83.

If you plan to use Microsoft SQL Server 2005, see Connecting to Microsoft SQL Server 2005 Databases
on page 76 for more information.
Caution: After you have started using StarTeam with Microsoft SQL Server:
•
•

Never modify the database contents other than through a StarTeam client or Server Administration
tool. Direct database manipulation is unsupported.
Never modify vault files other than through a StarTeam client or a Server Administration tool.
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Connecting to Microsoft SQL Server 2005 Databases
StarTeam Server requires Microsoft SQL Server authentication to connect to Microsoft SQL Server databases,
rather than the default Windows authentication. If you install Microsoft SQL Server 2005 using the default
settings for security and authentication, StarTeam Server will experience problems connecting to the database.
To specify the security to use when connecting to Microsoft SQL Server:
1. Start the Microsoft SQL Server Installation Wizard.
2. Go to the Authentication Mode page of the wizard.
3. Select Mixed Mode (Windows Authentication and SQL Server And Windows option button (instead of the
Windows Only option).
4. Type and retype the password to use.
5. Click Next to complete the rest of the wizard.

Creating and Starting a Server Configuration
The first time you start a new server configuration, StarTeam Server creates all of the StarTeam tables in the
database you specify. This section explains how to create a StarTeam server configuration and start it for the
first time. It assumes that you want StarTeam Server to automatically create a Microsoft SQL Server or SQL
Server Express database. If that is not the case, see Creating a Database Manually: Overview on page 83.
Microsoft SQL Server and SQL Server Express database names should:
•
•
•
•

Begin with a letter
Contain letters and numbers only
Not contain spaces
Not be a SQL reserved word such as create, delete, if, then, else, or goto

The Server Administration database options may fail to run for databases with names that do not follow these
guidelines.
To create a server configuration using a Microsoft SQL Server or SQL Server Express database:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
2009 ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
1. Type the name of the configuration in the Configuration Name text box.
If you want the server configuration to have the same name as the database (a nice convention, especially
if you have several server configurations), you must follow the naming conventions for Microsoft SQL
Server and SQL Server Express databases explained at the beginning of this section.
2. Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
3. Select Microsoft SQL Server/SSE (the default) from the Database Type drop-down list box.
4. Check the option to Create new StarTeam database and ODBC data source, so that StarTeam Server
automatically creates the database and the associated database DSN.

76

| Using StarTeam with Microsoft SQL Server and SQL Server Express Databases

5. Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•
•
•

•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

6. Click Next to create the SQL/SSE database.
4. Enter the server and database information:
1. Do one of the following:
•

•

If you are creating a server configuration on SSE, the Host Name text box defaults to
(local)\SSE2005_ST because the SSE instance on the computer on which StarTeam Server is
installed was given the name STARTEAM. Proceed to step b.
If you are creating a server configuration on Microsoft SQL Server, type or click Browse to specify
the names of the computer and the database on your network that should be used.

2. Enter the password for the system administrator in the Sys Admin (sa) Password text box.
If this is an SSE instance, the initial default system administrator password is StarTeam123.
3. Click Verify Connection to test the connection. If the test connection fails, review and change your
settings.
4. In the in the StarTeam Schema Information text box, type the name of the data source that you want
to create, the new database name, and the new user name for the configuration. This user is the owner
of the database.
5. Type the database password for the new database in the New Database Password and Confirm
Database Password text boxes.
6. Click Next.
5. Enter the information for creating the data files and transaction logs, and click Finish.
Note: Borland recommends keeping the data files and transaction log files on different physical drives
under their own disk controllers.
The default settings are appropriate for your use if you have fewer than 15 users and expect to store 1GB
or less data.
If you are very familiar with Microsoft SQL Server and SQL Server Express databases, you may choose
to make some changes by first clearing the Use Default Configuration check box and then altering sizes
and locations for data files and log files.
Use at least 3 data files and at least 3 transaction log files when creating a database, because Microsoft
SQL Server and SQL Server Express databases use a proportional fill strategy. This way all the files tend
to become full at about the same time.
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To avoid fragmentation, make the data files as large as possible, based on the maximum amount of data
expected in the database.
For more information, see Guidelines for Data Files and Transaction Logs on page 78.
The Server Administration tool displays your new server configuration as a child of the Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about this file,
see the Administering and Using StarTeam guide.
6. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server
configuration on a given computer must have a unique endpoint so it is recommended that you edit the
default endpoint.
To change the endpoint:
1. Select the server configuration.
2. Click the Start With Override toolbar button (or select Actions ➤ Start with Override from the main
menu). The Start with Override dialog box opens.
3. Enter the endpoint that you want to use in the TCP/IP Endpoint text box, and click OK.
Note: You can also change the location where attachments are stored using this dialog box, but you
rarely need to do this.
7. Be sure to configure your new server configuration (see the Administering and Using StarTeam guide for
more information) and plan a backup schedule for it.

Guidelines for Data Files and Transaction Logs
Based on the number of users, Borland suggests the following guidelines for data files and transaction logs.
Your needs may be different from those shown in the following table.
1

Number of Users

Number of Data Files Size of Each Data File Number of Log Files Size of Each Log File

Up to 15

3

50 MB

3

50 MB

Between 15 and 50

3

300 MB

3

300 MB

Between 51 and 100

5

300 MB

5

300 MB

Between 101 and 300 7

500 MB

5

500 MB

>300

800 MB

6

500 MB

7

1

The transaction log file sizes are relevant only if the Transaction log backup is performed frequently.

Transaction log backups are essential. After a transaction is backed up, Microsoft SQL Server and SQL Server
Express databases automatically truncate the inactive portion of the transaction log. This inactive portion
contains completed transactions and is no longer used during the recovery process. The basic advantage
comes with the fact that Microsoft SQL Server reuses this truncated, inactive space in the transaction log
instead of allowing the transaction log to continue to grow and use more space. This is a huge plus from a
performance standpoint.
Allowing files to grow automatically can cause fragmentation of those files if a large number of files share the
same disk. Therefore, it is recommended that files or file groups be created on as many different available
local physical disks as possible. Place objects that compete heavily for space in different file groups.
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Running SQL Scripts for Microsoft Databases
StarTeam Server comes with some SQL scripts written specifically for use with the Microsoft SQL Server and
SQL Server Express databases. These scripts help you maintain and tune StarTeam databases. You run
some SQL scripts after installation, some on a weekly basis for database performance maintenance, and some
scripts are run for you automatically by StarTeam Server.
The SQL scripts for Microsoft SQL Server and SQL Server Express databases that you may run are located
in the Borland\StarTeam Server 2009\DBScripts\ Sqlserver_Scripts folder.
Note: The Sqlserver_Scripts folder contains several subfolders: Create_Stored_Procedures,
Drop_Stored_Procedures, Install, Preinstall, and DW (for Data Warehouse). The scripts in
these subfolders are run by StarTeam Server as needed. Never execute any of them directly from an
external database user interface, such as SQL Query Editor.
The following table lists the SQL scripts that you are most likely to need. Some should be run manually on a
regular basis. The table recommends the frequency for running these scripts. You may adjust the frequency
depending on the StarTeam usage at your facility. Run scripts at times when the server is least used, such as
overnight or on weekends.
In addition to running these scripts, you should also run a Purge option from the Server Administration tool to
remove deleted views from the database. Borland recommends purging the database after you have deleted
one or more views from a StarTeam project. See the Administering and Using StarTeam guide for information
on the Purge option.
StarTeam Script Name

Run Frequency

starteam_sqlserver_dbcc.sql

Weekly

starteam_sqlserver_dbcc_reindex.sql

Twice a week (minimum)

starteam_sqlserver_dbcc_showcontig.sql

Twice a week (minimum)

starteam_sqlserver_dropall.sql

Only if necessary

Caution:
•

•

Before running any of the StarTeam SQL scripts for a Microsoft SQL Server or SQL Server Express
database, ensure that the database compatibility mode is set correctly. For Microsoft SQL Server
2005-based configurations, set the database compatibility mode to 90.
Be sure to backup your StarTeam database, as necessary, and verify these backups periodically. You
should restore and test backups of your StarTeam project data on a test system. Restoring and testing
your backups helps to ensure that your data is being backed up correctly.

To run a script for a Microsoft SQL Server or SQL Server Express database:
1. Install SQL Server Management Studio or SQL Server Management Studio Express from Microsoft.
2. Choose Start ➤ Microsoft SQL Server [or Microsoft SQL Server Express] ➤ SQL Server Manager
Studio [or SQL Server Manager Studio Express].
3. Design a new query or open an existing one in SQL Server Manager Studio.
4. Choose Query ➤ Connection ➤ Connect to connect to the server that contains the StarTeam database
you want to access.
5. Select the appropriate StarTeam database.
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6. Open the tuning script, by choosing File ➤ Open ➤ foldername\scriptname.
7. Execute the script, by clicking the Execute button on the toolbar or by pressing F5.

SQL Scripts for Microsoft SQL Server and SSE Databases
•

starteam_sqlserver_create_check_database.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_sqlserver_create_database.sql
Run: automatically by StarTeam Server when creating a new server configuration.
This script creates a new Microsoft SQL Server database.

•

starteam_sqlserver_create_upgrade_34.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_sqlserver_create_upgrade_36.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_sqlserver_create_upgrade_55.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_sqlserver_create_upgrade_58.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_sqlserver_dbcc.sql
Run: weekly.
The starteam_sqlserver_dbcc.sql script rebuilds the database indexes and performs a consistency check
on the database objects.This script builds the indexes and updates the statistics in the database distribution
pages.

•

starteam_sqlserver_dbcc_reindex.sql
Run: at least twice a week.
This script rebuilds all the indexes in the database. It is extremely important to run this script from time to
time.

•

starteam_sqlserver_dbcc_showcontig.sql
Run: at least twice a week.
This script gives information on database fragmentation.

•

starteam_sqlserver_dropall.sql
Run: only if necessary.
Caution: Running the starteam_sqlserver_dropall.sql script will delete all StarTeam tables and the
data they contain from the database. Use this script with extreme caution.
The starteam_sqlserver_dropall.sql script removes all StarTeam tables from the database. For example,
if you migrate a StarTeam server configuration to another database, you might use
starteam_sqlserver_dropall.sql to remove tables from the original database. Or if you mistakenly add the
StarTeam tables to a tablespace other than the StarTeam tablespace, use this script to remove them.
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•

starteam_sqlserver_get_dbinfo.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_sqlserver_get_dbpath.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_sqlserver_run_msde_backup.sql
Run: after you customize this sample script for your specific environment. You can run this script when
needed.
This sample script illustrates how to make a backup copy of a SQL Server Express database. Before you
can run this script, you must customize it for your specific environment. (Be sure to lock or shut down
StarTeam Server before backing up its database.)

•

starteam_sqlserver_update_statistics.sql
Run: only if necessary.
This script updates the statistics about the distribution of key values in each index, which SQL Server uses
to optimize query processing. You do not need to run this script if you have enabled automatic statistics
(using sp_autostats), or if you are regularly rebuilding the indexes (by running the
starteam_sqlserver_dbcc.sql or the starteam_sqlserver_dbcc_reindex.sql scripts).

Microsoft SQL Server Security
SQL Server 2005 uses a standard security model that involves the following entities and concepts:
•
•
•

Securable - Represents a resource or target object that requires securing, such as a database view.
Principal - Represents a user who requests access to a resource.
Permission - Access type that is associated with a securable. Permissions can be granted to or revoked
from principals. For example, Update is a permission that is associated with a table (securable) named R
. If Update on R is granted to a user (principal) named U , then U receives Update access on R.

Further, SQL Server 2005 supports the following security principals at different levels:
•
•
•

Windows-level principals - Control access to SQL Server instances for Windows Local Login and Windows
Network Domain Login.
SQL Server-level principals - Control access to SQL Server instances for SQL Server Login.
Database-level principals - Control access to database instances for database users.

To access a SQL Server instance, use a Windows user name or a SQL Server user name that was previously
created in that server instance. After you log on, the user name represents you as your security principal at
the server level.
If you try to use a specific database in the server, SQL Server searches the appropriate database for any
previous user who has been mapped to your user name. If SQL Server locates such a user, the corresponding
user name represents you as your security principal at the server level.

Orphaned Users
When a database user for a corresponding SQL Server Login is undefined or incorrectly defined, SQL Server
does not allow the user to log on to that instance. Such a user is said to be an orphaned user of the database
on that server instance. A database user can become orphaned if the corresponding SQL Server user name
is dropped. Most likely, a database user becomes orphaned after a database is restored or attached to a
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different instance of SQL Server. Orphaning can occur if the database user is mapped to a SID that is not
present in the new server instance.
Use SQL Server Management Studio or any other tool that executes SQL statements to address all orphaned
users before you start or upgrade the StarTeam Server configuration.

Addressing Orphaned Users
Use SQL Server Management Studio or any other tool that executes SQL statements to address all orphaned
users before you start or upgrade the StarTeam Server configuration. Use either the system administrator user
name (sa) or windows authentication (under an administrative user account) to connect to the database and
change the database context for the SQL console to the StarTeam database.
From the SQL console, enter the following command to display the user names of all orphaned users:
1. From the SQL console, enter the following command to display the user names of all orphaned users:
sp_change_users_login 'REPORT'
2. If the database owner (dbo) is returned as an orphaned user, enter the following commands:
a) sp_addlogin <UserName>, <Password>
where <UserName> is the appropriate user name and <Passwrord> is the appropriate password for
the StarTeam Server. If you do not specify a password, the default password is blank.
b) go
c) sp_changedbowner <UserName>
where <UserName> is the appropriate user name for the StarTeam Server.
d) go
3. For all other users who are returned as orphans, enter the following commands:
a) sp_addlogin <UserName>, <Password>
where <UserName> is the appropriate user name and <Passwrord> is the appropriate password for
the StarTeam Server. If you do not specify a password, the default password is blank.
b) go
c) EXEC sp_change_users_login 'Update_One', '<UserName>', '<UserName>'
where <UserName> is the appropriate user name for the StarTeam Server.
d) go
4. Copy the contents of the file
\Dbscripts\SQLServer_Scripts\starteam_sqlserver_set-owner-to-dbo.sql and paste
them to the SQL Server Query Window.
The directory \Dbscripts typically resides in StarTeam Server Installation directory.
5. Run the pasted SQL commands against the StarTeam database.
6. Execute the script by running the following command as the system administrator (sa):
exec change_db_ownership <UserName>
where <UserName> is the appropriate user name for the StarTeam Server
7. Use SQL Enterprise Manager (or SQL Server Management Studio for SQL Server 2005 ) and delete the
user starteam from the database.
8. Run the following command:
sp_changedbowner starteam
9. Log on as user starteam.
You must provide a password.
10. Run the following command:

82

| Using StarTeam with Microsoft SQL Server and SQL Server Express Databases

select * from s0
11. Verify that at least one row is returned.
You must address every orphaned user. An easy way to address an orphaned user is to drop the user after
dropping database objects owned by that user in the restored database.
For more information, refer to the Troubleshooting Orphaned Users section in the SQL Server 2005
documentation.

Creating a Database Manually: Overview
Despite the fact that StarTeam Server has automated Microsoft SQL Server and SQL Server Express database
creation, you may prefer to create your own. This makes more sense for Microsoft SQL Server because there
are good tools for database creation.
It is very important that you use the directions in the following procedure. In particular, be sure to use the
Latin1_General_CI_AS collation and make sure that you turn off the ODBC autotranslation feature when you
create your DSN.
Microsoft SQL Server and SQL Server Express database names should:
•
•
•
•

Begin with a letter
Contain letters and numbers only
Not contain spaces
Not be a SQL reserved word such as create, delete, if, then, else, or goto

The Server Administration database options may fail to run for databases with names that do not follow these
guidelines.
To create your own Microsoft SQL Server or SQL Server Express database:
1. Install Microsoft SQL Server or SQL Server Express.
Note: If you plan to use Microsoft SQL Server 2005, be sure to review the section Connecting to
Microsoft SQL Server 2005 Databases on page 76.
2. Install StarTeam Server. See Installing StarTeam Server on page 26 for more information.
3. Create a StarTeam database. Contact your database administrator about the specifics.
Be sure that:
•
•
•
•
•

The database is owned by a StarTeam user.
The default database for the StarTeam user is the StarTeam database.
The database will fit the expected growth patterns for storing your StarTeam data. See Guidelines for
Data Files and Transaction Logs on page 78 for more information.
The name of the database follows the conventions explained earlier in this section.
To create or upgrade the StarTeam database, the SQL Server instance must have one of the following
collations.
•
•
•

Latin1_General_CI_AS
Latin1_General_CI_AI
SQL_Latin1_General_CP1_CI_AS
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On a Japanese double-byte operating system, where the default collation for the SQL Server 2005
installation is not supported by StarTeam, you must use a named instance with one of the supported
collations.
Note:
The multi-instance feature of Microsoft SQL Server 2005 supports the use of multiple instances in
different locales on the same database server.
4. Create an ODBC DSN for the StarTeam database. See Creating an ODBC System DSN for the StarTeam
Database on page 84 for instructions.
5. Create and start a StarTeam server configuration. See Creating a Server Configuration (for an Existing
Database) on page 85 for instructions.

Creating an ODBC System DSN for the StarTeam Database
On the computer on which you installed StarTeam Server, create a System DSN for the new StarTeam database
using a Microsoft ODBC driver.
To create an ODBC System DSN for the StarTeam database:
1. From the Windows Start menu, select Start ➤ Settings ➤ Control Panel. The Control Panel dialog box
opens.
2. Open the ODBC Data Source Administrator dialog box by double-clicking first the Administrative Tools
icon and then the Data Sources (ODBC) icon.
3. Select the System DSN tab and, then click Add.
4. Select the Microsoft ODBC driver, SQL Native Client, version 2005.90.4035.00 or newer, and click Finish.
The SQL Server dialog box opens.
5. Type StarTeam in the Name text box, enter a description, select the Microsoft SQL Server you created for
StarTeam, and click Next.
6. Select With SQL Server authentication using a login ID and password entered by the user.
7. Check Connect to SQL Server to obtain default settings..., and enter the StarTeam user Login ID and
Password, and click Next.
8. Specify StarTeam as the default database. For example, if the computer’s name is Orion, you might select
ORION\STARTEAM.
9. Depending on the operating system, either click Next three times, or click Next once and then click Finish,
to display the page containing the Perform translation for character data check box.
10. Uncheck Perform translation for character data. This turns off the ODBC autotranslation feature. Doing
this is critical to the correct use of a StarTeam server configuration with a Microsoft SQL Server or SQL
Server Express database.
When this option is unchecked, no translation of extended characters in ANSI character strings is done
when they are sent between the client application and the server. Windows help says that “If the client
computer is using an ANSI code page (ACP) different from the SQL Server code page, extended characters
in ANSI character strings may be misinterpreted. If the client computer is using the same code page for its
ACP that SQL Server is using, the extended characters are interpreted correctly.” This is not an issue
because StarTeam Server manages the data.
11. Review the other ODBC DSN settings and then click Test Data Source. With the exception of the Perform
translation for character data check box, you can use the default settings.
12. Exit the wizard by clicking OK or Finish.
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Important: The SQL Server ODBC Data Source Test for the Microsoft ODBC driver will fail with the
message:
“Perform translation for character data” should be checked.
For Microsoft SQL Server and SQL Server Express databases used with StarTeam server configurations,
this option should not be checked, so the message is actually an indication that the option is correctly
set.

Creating a Server Configuration (for an Existing Database)
The first time you start a new server configuration, StarTeam Server creates all StarTeam tables in the database
you specify. This section explains how to create a StarTeam server configuration using a previously created
Microsoft SQL Server or SQL Server Express database.
Microsoft SQL Server and SQL Server Express database names should:
•
•
•
•

Begin with a letter
Contain letters and numbers only
Not contain spaces
Not be a SQL reserved word such as create, delete, if, then, else, or goto

To create a server configuration using an existing Microsoft SQL Server or SQL Server Express database:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
2009 ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
1. Type the name of the configuration in the Configuration Name text box.
If you want the server configuration to have the same name as the database (a nice convention, especially
if you have several server configurations), you must follow the naming conventions for Microsoft SQL
Server and SQL Server Express databases explained at the beginning of this section.
2. Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
3. Select Microsoft SQL Server/SSE (the default) from the Database Type drop-down list box.
4. Uncheck the option to Create new StarTeam database and ODBC data source, so that that StarTeam
will not automatically create the database and a DSN for it.
5. Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
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•
•
•

Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

6. Click Next, and then enter the Data Source Name, user name, and password in the appropriate text
boxes.
Note: If you are connecting to SSE installed with StarTeam Server, the initial password for the
sysadmin(sa) account was "StarTeam123".
7. If you are not sure of the values supplied, click Verify Connection to test the connection.
8. Click Finish.
This action re-displays the Server Administration tool, which shows your new server configuration as a
child of the Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about this
file, see the Administering and Using StarTeam guide.
4. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server
configuration on a given computer must have a unique endpoint so it is recommended that you edit the
default endpoint.
To change the endpoint:
1. Select the server configuration.
2. Click the Start With Override toolbar button (or select Actions ➤ Start with Override from the main
menu). The Start with Override dialog box opens.
3. Enter the endpoint that you want to use in the TCP/IP Endpoint text box, and click OK.
Note: You can also change the location where attachments are stored using this dialog box, but you
rarely need to do this.
5. Be sure to configure your new server configuration (for information, see the Administering and Using
StarTeam guide) and plan a backup schedule for it.

Understanding Collation
The physical storage of character strings in Microsoft SQL Server 2005 and Microsoft SQL Server 2005 Express
databases is controlled by collations. A collation specifies the bit patterns that represent each character and
the rules by which characters are sorted and compared.
Microsoft SQL Server 2005 supports objects that have different collations being stored in a single database.
Separate Microsoft SQL Server 2005 collations can be specified down to the level of columns. Each column
in a table can be assigned different collations.
In a computer, characters are represented by different patterns of bits being either ON or OFF. A program that
uses one byte (eight bits) to store each character can represent up to 256 different characters. A program that
uses two bytes (16 bits) can represent up to 65,536 characters.
Single-byte code pages are definitions of the characters mapped to each of the 256 bit patterns possible in a
byte. Code pages define bit patterns for uppercase and lowercase characters, digits, symbols, and special
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characters such as !, @, #, or %. Each European language, such as German or Spanish, has its own single-byte
code page. Although the bit patterns used to represent the Latin alphabet characters A through Z are the same
for all the code pages, the bit patterns used to represent accented characters (such as é and á) vary from one
code page to the next. If data is exchanged between computers running different code pages, all character
data must be converted from the code page of the sending computer to the code page of the receiving computer.
If the source data has extended characters that are not defined in the code page of the receiving computer,
data is lost. When a database serves clients from many different countries, it is difficult to pick a code page
for the database that contains all the extended characters required by all the client computers. Also, a lot of
processing time is spent doing the constant conversions from one code page to another.
Single-byte character sets are also inadequate to store all the characters used by many languages. For example,
some Asian languages have thousands of characters, so they must use two bytes per character. Double-byte
character sets have been defined for these languages. Still, each of these languages have their own code
page, and there are difficulties in transferring data from a computer running one double-byte code page to a
computer running another.
For information about synchronizing collation settings with another Windows locale, see the following Microsoft
site:
http://msdn2.microsoft.com/en-us/library/aa176553.aspx

How Is the Default Collation Selected?
If you upgrade a default instance of Microsoft SQL Server version 7.0 or Server 2000 to SQL Server 2005, or
if you install a default instance of Microsoft SQL Server 2005 that will be the version switched with a default
instance of Microsoft SQL Server version 6.5 or 7.0, SQL Server Setup carries forward the same collation
used in the existing instance of Microsoft SQL Server version 6.5 or 7.0, including obsolete collations.
In all other cases, SQL Server Setup chooses the Windows collation that supports the Windows locale of the
computer on which the instance of Microsoft SQL Server 2005 is being installed. If the computer is using the
US English locale, the instance’s default collation is Latin1_General_CI_AS.
Important: On a Japanese double-byte operating system, where the default collation for the SQL Server
2005 installation is not supported by StarTeam, you must use a named instance with one of the following
supported collations.
•
•
•

Latin1_General_CI_AS
Latin1_General_CI_AI
SQL_Latin1_General_CP1_CI_AS

The multi-instance feature of Microsoft SQL Server 2005 supports the use of multiple instances in different
locales on the same database server.
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Using StarTeam with Oracle Databases
This chapter explains how to create a new server configuration and Oracle schema user for use with StarTeam
Server. StarTeam Server stores everything except for file archives and server startup information in the schema
user.
This chapter also provides an overview of the tuning and maintenance SQL scripts that are provided with
StarTeam Server and explains how to use them.
When you create a server configuration, StarTeam Server can automatically create the tablespace, schema
user, and DSN. However, if you prefer, you can create the tablespace and schema user manually.
Note:
All of the tablespaces created using StarTeam Server automatically create locally-managed tablespaces.
All tablespaces created by StarTeam Server use AUTOALLOCATE.
StarTeam 2009 supports the Oracle 10.2.0.4.0 driver for use with the Oracle 10g R2 database, or the
Oracle 11.01.00.06 driver for use with the Oracle 11g database, on the StarTeam Server. Oracle databases
are supported on both 32- and 64-bit operating systems.
Important: You need to install the 10.2.0.4.0 or the 11.01.00.06 driver when you upgrade to StarTeam
2009.

Terminology for Oracle Databases
When this chapter uses database instance and schema user, it uses Oracle terminology. Each database
instance can manage a number of different schema users. Each StarTeam server configuration (such as the
StarDraw sample) has its own schema user.
Elsewhere in the StarTeam manuals, you will find the terminology common to the other databases that StarTeam
supports. For example, when you install Microsoft SQL Server 2005 on a computer, you can run several
instances of it. Each instance can manage a number of different databases. Therefore, when you see the term
“database” in other parts of these manuals, think “schema user”.

Logging Onto Schema Users
It is highly recommended that you use a dedicated StarTeam user account to run or log onto StarTeam schema
users. System administrator accounts usually have unlimited privileges. Any anomalies or errors that occur
while logged in as the system administrator may result in unrecoverable damage to the StarTeam schema
users and other schema users managed by the same database.

Overview of Using an Oracle Schema User
If you will be using an Oracle schema user, you must complete the following tasks:
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1. Install Oracle Server. Most customers install StarTeam Server and Oracle Server on separate computers.
2. Install Oracle Client on the computer on which you plan to install StarTeam Server.
3. Establish connectivity between Oracle Client and Oracle Server. Verifying Connectivity Between Client and
Server on page 89
4. Install Oracle ODBC drivers. Using Oracle ODBC Drivers on page 89
5. Install Oracle Enterprise Manager.
6. Install StarTeam Server. For more information, see Installing StarTeam Server on page 26
7. Make sure that the NLS_LANG setting for Oracle Client and the character set specified for Oracle Server
are correct. For more information, see Using NLS_LANG Correctly on page 90 and Database Character
Set and StarTeam Server on page 92
8. Create a StarTeam server configuration. For more information, see Creating and Starting a Server
Configuration with an Oracle Schema User on page 93 (about automatically created schema users) and
Overview of Creating the Oracle Schema User Manually on page 97
Caution:
After you have started using StarTeam with Oracle, remember:
•
•

Never modify the database contents other than through a StarTeam client or Server Administration
tool. Direct database manipulation is unsupported.
Never modify vault files other than through a StarTeam client or a Server Administration tool.

Verifying Connectivity Between Client and Server
If Oracle Client and Oracle Server are located on different computers (as recommended), verify that Oracle
Client can connect with the Oracle database instance. This ensures that a StarTeam server configuration can
access the Oracle schema user.
To verify the connection between Oracle Client and Oracle Server:
1. Using Oracle Client on the StarTeam Server computer, set up Oracle connectivity.
2. Use Net Configuration Assistant to establish the connectivity between the computers on which Oracle Client
and Server are installed.
3. Test the database connectivity through SQL*Plus or SQL*Worksheet.

Using Oracle ODBC Drivers
The StarTeam server requires the 10.2 client release, with the 10.2.0.4.0 ODBC driver.
The Oracle ODBC drivers enable applications that implement the Microsoft Open Database Connectivity
(ODBC) API to read from and write to Oracle database instances. Post-5.3 releases of StarTeam Server use
Oracle ODBC drivers for retrieval and storage of metadata.
The Oracle ODBC drivers require Oracle Net APIs to communicate with the Oracle Server. The default Oracle
Client installation includes the necessary NET libraries.
The Oracle ODBC driver distribution kit consists of dynamic link libraries, a Windows help file, a copy of the
license, and a product description.
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To use an ODBC-enabled application, the following software is required in addition to the Oracle ODBC Driver:
•
•

Oracle Net
Network transport on the client

Both of these components are installed during the installation of Oracle Client.

Verifying Oracle ODBC Drivers
To ensure that you have the correct ODBC driver:
1. Check the driver version for your release (for example, you can use ODBC ➤ Drivers ➤ Version).
2. If you have the wrong version, download and install the correct one. For more information, see Downloading
and Installing Oracle ODBC Drivers on page 90.

Downloading and Installing Oracle ODBC Drivers
Use the following URL to download supported Oracle ODBC driver:
http://www.oracle.com/technology/software/tech/windows/odbc
You use the Oracle Universal Installer to install ODBC drivers. The supported Oracle ODBC driver version
that you install depends on your requirements and company policies.
Make sure that the first three digits of the Oracle Client version match the first three digits of the ODBC driver.
For example, you cannot use an Oracle 10g Release 2 client (10.02.00) with an Oracle 10g Release 1 ODBC
driver (10.00.00).
Caution: If you have multiple Oracle homes on the StarTeam Server computer, make sure the Oracle
ODBC drivers are installed in the matching Oracle home. For example, when installing the 10.2.0.4.0
driver, make sure you select the Oracle 10 Release 2 home. Failure to do so will corrupt your installation.
After you start the self-extracting archive file for your Oracle client version, it creates an installable directory
structure on your local hard drive. Run the Oracle Universal Installer from your local drive.
To install the Oracle ODBC drivers:
1. From the Windows Start menu, choose Programs ➤ Oracle Installation Products ➤ Oracle Universal
Installer.
The Welcome page of the Oracle Universal Installer displays.
2. Follow the directions on the screen to complete the installation.
3. If a message dialog box is displayed warning you that some of the dependencies of this product are not
found in the staging area, click Yes to continue.

Using NLS_LANG Correctly
StarTeam Server converts data that is stored in the database to UTF-8 format. Your database character set
should be defined such that it will not conflict with this nor with other StarTeam Server requirements. For more
information, see Defining NLS_LANG in the Windows Registry on page 92.
NLS_LANG represents the Oracle Client character set. The Oracle Client character set is defined by the third
part of the NLS_LANG parameter.
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After setting NLS_LANG correctly, Oracle Client correctly translates any symbols to the character code values
of the database character set when storing data into the database or retrieving data from the database.
NLS_LANG is specified in the following format.
NLS_LANG = language_territory.characterset
where:
language
specifies the language used for Oracle messages, day names, and month names.
territory
specifies the monetary and numeric formats, territory, and conventions for calculating week and day numbers.
characterset
controls the character set used by Oracle Client. (Normally it matches your Windows code page.)

Overview of Defining NLS_LANG
The ODBC installation supports multiple Oracle homes. Each ODBC driver is uniquely identified by the name
of the Oracle home in which it is installed. Applications using Oracle ODBC drivers use the value of NLS_LANG
for making decisions related to character set conversion. The character set portion of the NLS_LANG setting
must be AMERICAN_AMERICA.WE8MSWIN1252. If your StarTeam database was previously Oracle 8i, then
you use AMERICAN_AMERICA.WE8ISO8859P1.
The ODBC driver installation uses the value of the Windows code page (ACP) and defines the value of
NLS_LANG in the registry. The value of NLS_LANG should be verified for accuracy. Be sure to check for the
NLS_LANG environment variable because it will override the registry setting. You may choose to delete the
variable. For more information, see Defining the NLS_LANG as an Environment Variable on page 92.
You can define NLS_LANG for the Oracle Client in either of the following ways:
•

In the Registry (Windows only)
For more information, see Defining NLS_LANG in the Windows Registry on page 92.
Oracle Client and Server support the concept of multiple Oracle homes. What this means is that you can
have multiple sets of Oracle binaries on the same computer. When you have multiple Oracle homes on the
same computer, you have multiple registry entries for each home. NLS_LANG should be defined for each
home.

•

As an environment variable
For more information, see Defining the NLS_LANG as an Environment Variable on page 92.
Although the Registry is the primary repository for environment settings, it is not the only place where
environment parameters can be set.You can set the NLS_LANG as a System or User Environment Variable
in the System properties.
Caution: If NLS_LANG is defined as an environment variable, it will be used for all Oracle homes.
This option should be used with caution, especially for cases where there are multiple Oracle homes
on the computer and some Oracle homes have different NLS_LANG settings. It may be best to delete
it.
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Defining NLS_LANG in the Windows Registry
Note: If NLS_LANG is not defined, it defaults to AMERICAN_AMERICA.US7ASCII.
To change the NLS_LANG setting using the Windows Registry Editor:
1. From the Windows Start menu, choose Start ➤ Run. The Run dialog box opens.
2. Type regedit, and then click OK.
3. Edit the following registry entry: HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\homeID
where homeID is the unique name identifying the Oracle home.

Defining the NLS_LANG as an Environment Variable
Note: If NLS_LANG is not defined, it defaults to AMERICAN_AMERICA.US7ASCII.
To create or modify the NLS_LANG environment variable’s setting on Windows:
1.
2.
3.
4.

Right-click the My Computer icon on your desktop, and then choose Properties from the context menu.
Select the Advanced tab.
Click Environment Variables. The Environment Variables dialog box opens.
Select NLS_LANG and define an appropriate value.
To create or modify this setting for UNIX, define the value of NLS_LANG in the .profile or .cshrc file. Contact
your UNIX Admin to learn how to set environment variables.

Database Character Set and StarTeam Server
StarTeam Server stores UTF-8 data in Oracle schema users. StarTeam Server does not use the Oracle
conversion mechanism. It performs the conversion to UTF-8 itself.
Caution: Because StarTeam Server does the conversion, it is very important to prevent Oracle Client
from also converting the data. A double conversion will result in garbage.
Oracle software does the conversion only when the Oracle Client’s character set (specified by NLS_LANG)
does not match the database instance’s character set. Therefore, it is very important that the client and server’s
settings match. StarTeam server configurations require that Oracle database instances use the WE8MSWIN1252
character set. If your StarTeam database was previously Oracle 8i, then Oracle database instances use the
WE8ISO8859P1 character set.
The Server Administration tool does not allow you to create a new StarTeam server configuration unless the
underlying database instance’s character set is the correct character set. As StarTeam Server starts, it also
ensures that the database character set matches the characters set portion of NLS_LANG.
Due to the numeric setting differences between different languages and territories, StarTeam Server also does
not start unless AMERICAN_AMERICA (the US numeric setting) is the setting for the language_territory portion
of NLS_LANG. Failure to do so causes exceptions for StarTeam Server. This does not mean that numbers
and so on will be displayed incorrectly. For example, in Germany and other countries, a decimal point is
represented as a comma. German numbers will still display correctly.
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Creating and Starting a Server Configuration with an Oracle
Schema User
The first time you start a new server configuration, StarTeam Server creates all the StarTeam tables in the
database you specify. This section explains how to create a StarTeam server configuration and start it for the
first time. It assumes that you want StarTeam Server to automatically create the Oracle tablespace and a
schema user named StarTeam. If that is not the case, see Overview of Creating the Oracle Schema User
Manually on page 97.
Before you begin, you need to know the Oracle database’s net service name (the Oracle net service name
that is stored in either C:\ORACLE_HOME\network\admin\tnsnames.ora or
$ORACLE_HOME/network/admin/tnsnames.ora, depending on your operating system), and the system
password.
To create a server configuration with an Oracle schema user:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
2009 ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
1. Type the name of the configuration in the Configuration Name text box.
2. Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
3. Select Oracle from the Database Type drop-down list box.
4. Check the option to Create new StarTeam database and ODBC data source, so that StarTeam Server
automatically creates the tablespace, schema user, and a DSN for the schema user.
5. Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•
•
•

•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

6. Click Next. The Create an Oracle Schema User page of the wizard opens.
7. Type the Oracle net service name in the TNS service name text box.
8. Enter the database system password in the System password text box.
9. Click Verify Connection to make sure that you can properly connect to the database.
10. To keep the name of the server configuration, the DSN, and the schema user the same, both the New
ODBC data source and the New schema user name text boxes default to the name you provided
earlier for the server configuration. Change these names if you prefer to use different values.
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11. Enter and confirm a password for the schema user name.
12. Click Next. The Create a Tablespace for StarTeam Schema page of the wizard opens.
13. The tablespace name defaults to the name of your server configuration. Change this name if you prefer
to use a different value.
14. If you have fewer than 15 users and expect to store 1 GB or less of data, the default settings are
appropriate for your use.
If you are very familiar with Oracle schema users, you may choose to alter the names, sizes, and locations
of the data files. For more information, see Guidelines for Data Files on page 94.
To avoid fragmentation, make the data files as large as possible, based on the maximum amount of
data expected in the database.
Use at least three data files when creating a tablespace because:
•
•

There is a size limit of 2 GB per data file.
Fewer files can result in slow response times when insert activity is heavy.

15. Click Finish.
The Server Administration window re-displays, showing your new server configuration as a child of the
Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about
this file, see StarTeam Help or the Administering and Using StarTeam manual which are both accessible
from the Borland StarTeam ➤ StarTeam Cross-Platform Client 2009 ➤ Documentation submenu.
These documents explain the file options and how to set them from the command line.
4. By default, all server configurations are set to use the TCP/IP endpoint (port) 49201. However, each server
configuration on a given computer must have a unique endpoint so it is recommended that you edit the
default endpoint.
To change the endpoint:
1. Select the server configuration.
2. Click the Start With Override toolbar button (or select Actions ➤ Start with Override from the main
menu). The Start with Override dialog box opens.
3. Enter the endpoint that you want to use in the TCP/IP Endpoint text box, and click OK.
Note: You can also change the location where attachments are stored using this dialog box, but you
rarely need to do this.
5. Be sure to configure your new server configuration (see the Administering and Using StarTeam guide for
more information) and plan a backup schedule for it.

Guidelines for Data Files
Borland suggests the following guidelines for the number of data files and their sizes, based on the number
of users. Your needs may be different than those shown in the table below.
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Number of Users

Number of Data Files

Size of Each Data File

Up to 15

3

50 MB
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Number of Users

Number of Data Files

Size of Each Data File

Between 15 and 50

3

300 MB

Between 51 and 100

5

300 MB

Between 101 and 300

7

500 MB

>300

7

800 MB

Running SQL Scripts for Oracle Schema Users
StarTeam Server comes with some SQL scripts written specifically for use with the Oracle schema users.
These scripts help you maintain and tune StarTeam databases. You run some SQL scripts after installation,
some on a weekly basis for database performance maintenance, and some scripts are run for you automatically
by StarTeam Server.
The SQL scripts for Oracle schema users that you may run are located in the Borland\StarTeam Server
2009\DBScripts\Oracle_Scripts folder.
Note: The Oracle_Scripts folder contains several subfolders: Create_Stored_Procedures,
Drop_Stored_Procedures, Install, Preinstall, and DW (for Data Warehouse). The scripts in
these subfolders are run by StarTeam Server as needed. NEVER execute any of them directly an external
database user interface, such as SQL*Plus or SQL *Worksheet.
The following table lists the SQL scripts that you are most likely to need. Some should be run manually on a
regular basis. The table recommends the frequency for running these scripts. You may adjust the frequency
depending on the StarTeam usage at your facility. Run scripts at times when the server is least used, such as
overnight or on weekends.
In addition to running these scripts, you should also run a Purge option from the Server Administration tool to
remove deleted views from the schema user. Borland recommends purging the schema user after you have
deleted one or more views from a StarTeam project. See the Administering and Using StarTeam guide for
information on the Purge option.
StarTeam Script Name

Run Frequency

starteam_oracle_compute_stats.sql

Weekly

starteam_oracle_dropall.sql

Only if necessary

starteam_oracle_rebuild_indexes.sql

Weekly

For a description of these scripts, see StarTeam SQL Scripts for Oracle Schema Users on page 96.
Caution: Be sure to backup your StarTeam schema user, as necessary, and verify these backups
periodically.You should restore and test backups of your StarTeam project data on a test system. Restoring
and testing your backups helps to ensure that your data is being backed up correctly.
To run a SQL script for Oracle schema users:
1. Go to the command prompt.
2. Change directories to the directory containing the StarTeam SQL scripts for Oracle schema users.
3. At the command prompt, type:
sqlplus username/password@servicename
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where
username is the StarTeam Oracle Schema User Name
password is the StarTeam Oracle Schema Password
servicename is the Net Service Name created using Oracle Net 8 Easy Config
4. Execute the script. For example, to execute the starteam_oracle_compute_stats.sql script, type
@starteam_oracle_compute_stats.sql and press Enter.

StarTeam SQL Scripts for Oracle Schema Users
•

starteam_oracle_compute_stats.sql
Run: weekly.
The starteam_oracle_compute_stats.sql script updates the statistics in the database distribution page for
all tables in the database. This data enables the query optimizer to choose the right index for a given query.

•

starteam_oracle_create_check_database.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_oracle_create_check_privileges.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_oracle_create_database.sql
Run: automatically by StarTeam Server when creating a new server configuration.
This script creates a new Oracle schema user.

•

starteam_oracle_create_fix_custom_fields.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_oracle_create_upgrade_33.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_34.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_35_catalog.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_35_data.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_36.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_55.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_create_upgrade_58.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•
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Run: weekly.
•

starteam_oracle_create_fix_dup_login_names.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_extract_ddl.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

n starteam_oracle_fix_long_raw.sql
Run: automatically by StarTeam Server when upgrading a server configuration.

•

starteam_oracle_dropall.sql
Run: only if necessary.
Caution: Running the starteam_oracle_dropall.sql script will delete all StarTeam tables and the data
they contain from the database. Use this script with extreme caution.
The starteam_oracle_dropall.sql script removes all StarTeam tables from the database. For example, if
you migrate a StarTeam server configuration to another database, you might use starteam_oracle_dropall.sql
to remove tables from the original database. Or if you mistakenly add the StarTeam tables to a tablespace
other than the StarTeam tablespace, use the starteam_oracle_dropall.sql script to remove them. This script
can be executed from either Sql*Plus or SQL*Worksheet.

•

starteam_oracle_get_dbinfo.sql
Run: automatically by StarTeam Server when appropriate.

•

starteam_oracle_rebuild_indexes.sql
Run: weekly.
The starteam_oracle_rebuild_indexes.sql script rebuilds the database indexes and configures the storage
parameters for the index tablespace. The script assumes that the indexes are located in a tablespace
named INDX. If your index tablespace uses a different name, edit starteam_oracle_rebuild_indexes.sql to
reflect the correct tablespace name. Run the starteam_oracle_rebuild_indexes.sql script weekly to enhance
database data retrieval.

Overview of Creating the Oracle Schema User Manually
This section explains how to manually create an Oracle tablespace and schema user for StarTeam Server. It
also provides an overview of the tuning and maintenance SQL scripts that are provided with StarTeam Server,
and explains how to use them. For detailed information on Oracle performance tuning, consult your Oracle
documentation.
To configure an Oracle database instance:
1.
2.
3.
4.

Complete the procedures described in Overview of Using an Oracle Schema User on page 88.
Create a StarTeam tablespace.
Create a StarTeam schema user.
To ensure that StarTeam Server can create labels and perform other operations successfully, make sure
that the schema user has the following Oracle privileges. They must be explicitly defined rather than
relegated to roles. For more information, see Granting Oracle Privileges on page 24.
•
•

create procedure
create sequence
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•
•
•
•
•
•
•
•

create session
create table
create trigger
create type
create view
unlimited tablespace
create any context
drop any context

5. Create an ODBC DSN for the StarTeam schema user. For more information, see Creating ODBC System
DSNs for Oracle on page 98.
6. Create the server configuration. For more information, see Creating a Server Configuration for an Oracle
Schema User on page 98.

Creating ODBC System DSNs for Oracle
StarTeam Server uses ODBC drivers to access Oracle schema users.
To create an ODBC DSN for an Oracle schema user:
1. From the Windows Start menu, select Start ➤ Settings ➤ Control Panel. The Control Panel dialog box
opens.
2. Open the ODBC Data Source Administrator dialog box by double-clicking first the Administrative Tools
icon and then the Data Sources (ODBC) icon.
3. Select the System DSN tab and then click Add.
4. Select the correct Oracle driver and then click Finish. The Oracle ODBC Driver Configuration dialog box
opens.
5. Enter the DSN in the Data Source Name text box. If you have only one StarTeam server configuration,
use the database’s Oracle Net service name as the DSN. If you have more than one server configuration,
have the DSNs match the name of each server configuration.
6. Enter a description in the Description text box.
7. Select the Oracle Net service name from the TNS Service Name text box.
8. Type the user name in the User ID text box.
9. Click Test Connection to verify that you can connect to this database.
Important: It is recommended that you do not change any other settings.
10. Click OK.

Creating a Server Configuration for an Oracle Schema
User
The first time you start a new server configuration, StarTeam Server creates all the StarTeam tables in the
database you specify. This section explains how to create a StarTeam server configuration and start it for the
first time.
Before you begin, you need to know:

98

| Using StarTeam with Oracle Databases

•

•
•
•

The Oracle database’s net service name (TNS name that is stored in either
C:\ORACLE_HOME\network\admin\tnsnames.ora or
$ORACLE_HOME/network/admin/tnsnames.ora, depending on your operating system)
The system password
The ODBC DSN
The logon name and password for the schema user

To create a server configuration:
1. Start the Server Administration tool. Select Start ➤ Programs ➤ Borland StarTeam ➤ StarTeam Server
2009 ➤ StarTeam Server. The Server Administration tool opens.
2. Choose Server ➤ New Configuration. The New Configuration dialog box opens.
3. Enter the new configuration data:
1. Type the name of the configuration in the Configuration Name text box.
2. Type or click Browse to specify the Repository Path location to be used to store log files and other
information. If the repository path that you enter does not exist, the application creates it for you. The
Repository Path is also the location for the default hive.
3. Select Oracle from the Database Type drop-down list box.
4. Clear the option to Create new StarTeam database and ODBC data source, so that StarTeam Server
does not automatically create the tablespace, schema user, and a DSN for the schema user.
5. Create an initial hive for the Native-II vault by doing one of the following:
•

Accept the default settings by leaving the Default option selected and proceeding to step 6.
With the default settings, StarTeam Server:
•
•
•
•
•

•

Creates an initial hive named DefaultHive.
Creates subfolders on the repository path named Archives and Cache to be used by the
DefaultHive.
Stipulates that the maximum cache size is 20% of the space currently available on the drive on
which the cache is located.
Uses the default setting of 600 seconds (10 minutes) between cache cleanups.
Uses the default setting of 95% for the storage threshold, the point at which this drive is considered
full.

Specify custom values by selecting the Custom option and changing any of the hive settings.

6. Click Next. The Database Information page of the wizard opens.
7. Enter the ODBC DSN in the ODBC data source name text box.
8. Enter the login name and password for the schema user in the appropriate text boxes.
9. Click Verify Connection to be sure that you can successfully access the schema user.
10. Click Finish.
This action re-displays the Server Administration window, which shows your new server configuration as
a child of the Local node.
Note: In addition to creating the server configuration, StarTeam Server adds information about the
new server configuration to your starteam-server-configs.xml file. For more information about
this file, see StarTeam Help or the Administering and Using StarTeam manual which are both accessible
from the Borland StarTeam ➤ StarTeam Cross-Platform Client 2009 ➤ Documentation submenu.
These documents explain the file options and how to set them from the command line.
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Understanding Data Locations
As part of creating a new server configuration, StarTeam Server creates a number of folders for storing log
files, attachments, archive files, and so on. This section explains the location and purpose of the files and
folders that make up the StarTeam vaults and repositories.

Understanding Repositories
The following figure shows the server configuration whose repository path starts with a drive letter (not shown
in figure) and ends with the folder name MyConfiguration.

The name of the server configuration may also be MyConfiguration.
The repository path is a general location for initial storage of a variety of objects, most of which can be moved
to new locations later, independent of one another.

Attachments Folder
The repository path, such as the MyConfiguration folder in the previous figure, is also the parent of the
Attachments folder.
The Attachments folder has subfolders that store the files attached to specific types of items. For example,
the Changes_Attachments folder contains files attached to change requests.

You can change the path to the Attachments folder independently by changing the Attachments Path on the
General tab of the Server Configuration dialog box. This folder does not have to remain a subfolder of the
repository path.
These folders must be included in a backup.
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Native-II Vault Folders
For server configurations, whether newly created in or upgraded to StarTeam Server 2005 or a later release,
the repository path is also the initial home of several folders used by the Native-II Vault to store archive files
and information about them:
•

Default Hive
If you accepted all the defaults when you created the server configuration or if you started an upgraded
server configuration without first creating a hive, StarTeam Server automatically creates the folder
DefaultHive. It is a subfolder of the repository path and is created when you start the server configuration
for the first time.

Whether the initial hive is called DefaultHive or not, you will have at least one hive for each server
configuration. You may have several hives. Each hive has an archive and cache path. An easy, but not
mandatory, naming convention is the one illustrated in the above figure. The name of the hive becomes
the name of a folder with two subfolders: Archives and Cache. However, you can place these paths anywhere.
They do not need to be on the same drive or volume.
The DefaultHive subfolders have the following purposes:
•

Archives
This folder stores file revisions in archive files, which may be compressed.

•

Cache
This folder stores uncompressed versions of archive files. It has two subfolders Temp and Deltas. Temp
is used for files that are being added to StarTeam and for new file revisions that are being checked in.
Deltas stores the differences between working files and tip revisions when a user asks that transmissions
over slow connections be optimized.

You can use the Hive Manager to change an individual hive’s archive path and/or cache path. Such changes
should be done only when that hive must be moved. For example, you might move a hive as a result of a
drive failure. You would also need to copy the contents of the hive’s archive path to the new location.
The archive path for any hive must be included in a backup. A hive’s cache path does not need to be
included. For more information, see Archive and Cache Path Structure on page 102.
•

HiveIndex
If you have started a 2005 or later server configuration, it has at least one hive. The HiveIndex folder stores
the hive-index.xml file, which contains the properties for each hive used by the server configuration.
You can change the path to the HiveIndex folder by changing the repository path in the
starteam-server-configs.xml file. You would make this change only when necessary, for example, because
of a drive failure.
The HiveIndex folder must be included in a backup. For more information, see Archive and Cache Path
Structure on page 102.
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Archive and Cache Path Structure
Every hive's archive path and cache path has the same structure. This structure is similar to that used by
StarTeam clients to store file status records. The files located in the archive and cache are organized into
subfolders. This makes browsing and managing the files easier. The name of the subfolders in which a file
revision is stored is based on the initial characters in the archive file's name. For example, suppose a file
revision's contents has an MD5 value of 01fc3c4ac5e0e92cc707f30fb73a0726. Assuming the user
specified an archive path of C:\DefaultHive\Archives the archives path for this revision would be one
of the following, depending on whether or not the archive file was compressed:
C:\DefaultHive\Archives\01\f\01fc3c4ac5e0e92cc707f30fb73a0726
C:\DefaultHive\Archives\01\f\01fc3c4ac5e0e92cc707f30fb73a0726.gz
The figure below shows the path from an Archives folder to an archive file.

The archive path for each hive (for example C:\DefaultHive\Archives) must be included in a backup.
See StarTeam Help or the Administering and Using StarTeam guide for more information.

Log Files and Folders
The repository path folder becomes the home of the following related objects.
•
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A new server log file is created each time you start the server configuration. See the Administering and
Using StarTeam guide for more details about server logs.
•

Any .dmp files created when you use server diagnostics to create .dmp files for errors and unexpected
conditions encountered by the server.
Usually, you have no .dmp files or trace files unless a Borland technical support representative is working
with you on a problem. See the Administering and Using StarTeam guide for more details about server
diagnostics.

•

The Notifications folder
When a server configuration starts for the first time, the contents of the Notifications folder in the installation
directory are copied to the repository for the server configuration in a corresponding Notifications folder.

•

The Trace folder
The Trace folder stores the files that are created when and if you use server diagnostics to trace server
commands. See the Administering and Using StarTeam guide for more details about server diagnostics.

These objects do not have to remain in the repository path. You can change the path to all of the above by
changing the Log Path using the Server Administration tool. See the Administering and Using StarTeam guide
for more information.
These folders do not have to be included in a backup.
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Installing and Configuring Supporting
Software
This appendix provides information about software that you use in conjunction with StarTeam:
•
•
•

Synchronizing workstation clocks
Adobe Acrobat Reader
Java runtime environment

Synchronizing Workstation Clocks
The computers that run application clients and the Server must have their dates and times synchronized. Many
features of the application depend on calculations involving times and dates. In particular, labels, configurations,
and promotion states are all governed by time and date calculations.
Important: If the client and server are not kept synchronized, a number of operations (such as checkout,
file status displays, or label creation) might fail or produce inaccurate results.
Therefore, you should use whatever service your network server supports for synchronizing all workstation
clocks. For example, Windows network users can execute the following command to synchronize their
workstation time with the computer on which the Server is installed:
net time \\server_name /set /yes
In this example, you would replace server_name with the machine name or IP address of the network
computer running the Server.

Adobe Acrobat Reader
The primary documentation for the StarTeam product line is delivered in Adobe’s Portable Document Format
(.pdf), and can be viewed with version 7.0 or later of Adobe’s free Acrobat Reader. You can download the
latest version of the Acrobat Reader from Adobe’s web site at http://www.adobe.com.

Installing the Java Runtime Environment
The application client and server installation programs automatically install a Sun Microsystems Java Virtual
Machine on your computer if the required version is not already installed.
Java requires a minimum of 256 colors to start any AWT or Swing-based graphical user interface. When you
try to start the Server from the Windows Start menu on a computer with too few colors, you see a DOS box
blink on the screen then go away.
The StarTeam Cross-Platform Client installer runs the Sun tzupdater program on the Sun JRE (1.6.0_13)
installed with this release. The tzupdater program changes the JRE in order to provide better DST (Daylight
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Savings Time) information for Eastern, Mountain, and Hawaiian time zones. It also deletes three JRE files
from the lib/zi folder (if they are there): EST, HST, MST.
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Backing Up Databases
This chapter outlines the backup options available to DBAs and makes recommendations for backing up the
databases used by the server configurations. Be aware that these are just recommendations. Any finalized
disaster recovery plan must be created by your organization in consultation with its IT infrastructure staff.
An application backup consists of backing up both the database and the application archive files. Starting with
StarTeam Server 2005, you have a choice between online and offline backups. If all of your archive files are
in Native-II format, you can back up a server configuration online—without shutting it down or locking it. If your
have a pre-2005 StarTeam Server release, you must convert older archives from Native-I to Native-II format
prior to performing an online backup. Regardless of the Server release, you must also set up your database
for an online backup.

Backing Up SQL Server Databases
For server configuration online backups, it is essential to take full database and transaction log backups.
SQL Server 2005 supports the following types of backups:
•

Full database backup
A full database backup contains the full copy of the database as it was at the time when the backup was
initiated. Full backups provide a snapshot of the database. Most of the recovery options require a full backup
to be available.

•

Differential backup
A differential database backup records only the data that has changed since the last full database backup.
Scheduling frequent differential backups is a good idea because the backups are smaller and they complete
quickly. A differential backup without a prior full backup is useless.

•

Transaction log backup
A transaction log backup includes all the transactions since the last transaction log backup. Transaction
log backups enable recovery up to the last committed transaction.

•

A file or file group backup
A file or file group backup consists of backing up individual data files (or the files in the file group). The files
in a database can be backed up and restored individually.

The entire database can be recreated from a database backup in one step by restoring the database. The
restore process overwrites the existing database or creates the database if it does not exist. The restored
database will match the state of the database at the time the backup completed, minus any uncommitted
transactions. Uncommitted transactions are rolled back when the database is recovered.
Based on the resource requirements, the DBA can also choose the recovery model for the database. The
recovery model balances logging overhead against the criticality of fully recovering the data.
The recovery models supported by SQL Server 2005 are:
•
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The data is critical and must be recoverable to the point of failure. All data modifications are logged. All
SQL Server 2005 recovery options are available.
•

Bulk-logged
Certain bulk operations, such as bulk copy operations, SELECT INTO, and text processing, can be replayed
if necessary, so these operations are not fully logged. You can recover only to the end the last database
or log backup.

•

Simple
All data modifications made since the last backup are not available. This type of recovery scenario has the
lowest logging overhead, but cannot recover past the end of the last backup.

Recovering to a point-in-time (for example, a time before unwanted data was entered) requires either full or
bulk-logged recovery models.

Full Database Backup
A full database backup creates a duplicate of the data that is in the database. This is a single operation, usually
scheduled at regular intervals. Full database backups are self-contained. Full backups provide a snapshot of
the database. Most of the recovery options require a full backup to be present.
Borland strongly recommends the use of full backups.

Differential Database Backup
A differential database backup records only the data that has changed since the last database backup. Frequent
differential backups are recommended to reduce backup times. Making frequent backups decreases the risk
of losing data.
Differential backups restore the data that they contain to the database. Differential backups cannot be used
to recover the database to a point in time.
The availability of a differential backup minimizes the time it takes to roll forward transaction log backups when
restoring a database.

Transaction Log Backups
The transaction log is a serial record of all the transactions that have been performed against the database
since the transaction log was last backed up. With transaction log backups, you can recover the database to
a specific point in time or to the point of failure.
When restoring a transaction log backup, SQL Server rolls forward all the changes recorded in the transaction
log. When SQL Server reaches the end of the transaction log, it has re-created the exact state of the database
at the time of the backup operation.
If the database is recovered, SQL Server then rolls back all transactions that were incomplete when the backup
operation started. Transaction log backups generally use fewer resources than database backups. As a result,
you can create them more frequently than database backups. Frequent backups decrease the risk of losing
data. For high volume Online Transaction Processing (OLTP) environments, it is desirable to create transaction
log backups more frequently.
Transaction log backups can only be used with Full and bulk-logged recovery models.
The transaction log cannot be backed up during a full database backup or a differential database backup.
However, the transaction log can be backed up while a file backup is running.
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Never backup a transaction log before a database backup is created because the transaction log contains the
changes made to the database after the last backup was created.
Never truncate the transaction log manually because it breaks the backup chain. If a transaction log has been
truncated, take a full database backup to start a new backup chain.

File Backups
A file or file group backup consists of the backing up of individual data files (or the files in the file group). A
file-based recovery model increases the speed of recovery by allowing you to restore only the damaged files
without restoring the rest of the database. For example, suppose a database is comprised of several files
located physically on different disks and one disk fails. Only the file on the failed disk needs to be restored and
rebuilt using the transaction log backup.
File backup and restore operations must be used in conjunction with transaction log backups. For this reason,
file backups can only be used with the full recovery and bulklogged recovery models.

Recommendations
Borland recommends that you:
•
•

•

Use the full recovery model
Perform a full database backup once every day. For full database sizes greater than 3 GB, it is okay to
perform full backups on alternate days. If you perform full backups on alternate days, Borland strongly
recommends that you create daily differential backups.
Create daily transaction log backups after the completion of the full or differential backup.
In addition to this, schedule a transaction log backup every 4 hours.
Never truncate a transaction log manually.

•

In case of a disaster, create a backup of the currently active transaction log.
If active transaction log backup is not available (for example, because a media failure for the drive hosting
the transaction logs and drive is not being mirrored), the database cannot be recovered past the last available
transaction log backup. This would hamper a point-in-time recovery beyond the last available transaction
log backup.

•
•

Label the backup tapes correctly.
Keep backup copies in offsite locations.

Backing Up Oracle Databases
An online or hot backup is a backup performed while the database is online and available for read/write
operations. Except for Oracle exports, you can only perform online backups when running in ARCHIVELOG
mode. An offline or cold backup is a backup performed while the database is offline and unavailable to its
users.
Typically an Oracle DBA uses one or more of the following options to back up an Oracle database.
•

Export/Import
Exports are “logical” database backups that extract logical definitions and data from the database to a file.

108

| Backing Up Databases

Export backups are cross-platform and can be easily moved from one operating system to the other.
•

Cold or Offline Backups
These backups require shutting down the database instance and copying all the data, log, and control files.

•

Hot or Online Backups
These backups are taken when the database is available and running in ARCHIVELOG mode. To perform
a backup of this type, the tablespaces need to be in backup mode and all the data files associated with the
tablespace must be backed up. It is essential to backup the control files and archived redo log files.

•

Recovery Manager (RMAN) Backups
While the database is offline or online, DBAs can use the RMAN utility to back up the database.

•

Export/Import Data Pump
Export pump and import pump are new for Oracle 10g. Expdp and Impdp are crossplatform and can be
easily moved from one OS to the other.

Logical Backups (Export/Import)
Oracle exports are “logical” database backups (not physical) as they extract data and logical definitions from
the database into a file. Other backup strategies normally back up the physical data files. One of the advantages
of exports is that you can selectively re-import tables. However, you cannot roll forward from a restored export
file. To completely restore a database from an export file, you almost need to recreate the entire database.
Logical backups takes a snapshot of the database schema as it was at a particular time.

Offline/Cold Backups
A backup performed when the database is shut down is known as an offline or cold backup. You must copy
the data files, control file and online redo log files using an OS copy utility. This is a considered a complete
backup of the database. Any changes made after this backup are unrecoverable if the database is running in
NOARCHIVELOG mode. All transactions are recorded in online redo log files whether the database is archiving
or not. When redo logs are archived (ARCHIVELOG mode), ORACLE allows you to apply these transactions
after restoring files that were damaged (assuming that an active redo log file was not among the files damaged).
Whenever the schema of the database is changed, such as when you add a new data file, rename a file, or
create or drop a tablespace, you must shut down the database and copy at least the control file and the newly
added data file. A complete backup of the database is preferred.
Before performing a cold backup, it is essential to get a list of all the Oracle files that need to be backed up.
Running the following queries will provide a list of all the files.
select name from sys.v_$datafile;
select member from sys.v_$logfile;
select name from sys.v_$controlfile;
Shut down the database from SQL*Plus or Server Manager. Back up all the files to secondary storage (for
example, tapes). Ensure that you back up all data files, all control files, and all log files. When completed,
restart your database.
Note: If your database is in ARCHIVELOG mode, you can still use archived log files to roll forward from
an offline backup. If you cannot take your database down for an offline backup at a convenient time, switch
your database into ARCHIVELOG mode and perform an online backups.
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Online/Hot Backups
A backup performed when the database instance is running is known as online or hot backup. Online backups
are very important at customer sites where a database instance must operate 24-hours per day and offline
backups are not feasible. During the duration of an online backup, the database remains available for both
reading and updating. For this kind of backup, the database must be in ARCHIVELOG mode. Only data files
and current control files need to be backed up. Unlike offline backups, the unit of a online backup is a tablespace,
and any or all tablespaces can be backed up whenever needed. Different data files can be backed up at
different times.
To perform an online backup, you switch the tablespace into “backup mode” before copying the files as shown
in the following example.
ALTER TABLESPACE xyz BEGIN BACKUP;
! cp xyfFile1 /backupDir/
ALTER TABLESPACE xyz END BACKUP;
It is better to backup individual tablespaces than to put all tablespaces in backup mode at the same time.
Backing them up separately incurs less overhead. After completing the tablespace backups, it is important to
back up the control files as shown in the following example.
ALTER SYSTEM SWITCH LOGFILE; --Force log switch to update control file headers
ALTER DATABASE BACKUP CONTROLFILE TO '/directory_name/control.dbf';
The frequency of online backups is inversely proportional to the time taken for recovery in case of a media
failure. The older your backup, the more redo log files need to be applied, and the recovery times increases.
Backup strategies should be tested before being used to protect a production database.
Borland strongly recommends that you run online backups at times when the database is least accessed,
during non-peak hours. Oracle writes complete database blocks instead of the normal deltas to redo log files
while in backup mode. This leads to excessive database archiving and could lock up the database.

RMAN Backups
Recovery Manager (RMAN) is an Oracle tool that lets the DBA back up and recover Oracle databases. RMAN
lets you perform full backups (with the database online or offline), incremental backups on the block level, and
backups of online redo logs and control files.
The SYSDBA privilege is required to run RMAN on a database. The other benefits of RMAN backups are that
you can:
•
•
•
•
•

Keep track of all backup and recovery operations performed against the database.
Manage centralized backup and recovery procedures for the enterprise.
Identify corrupt blocks.
Back up only those blocks that actually contain data. This can lead to significant savings in backup space
requirements.
Have support for incremental backups.
Incremental backups back up only those blocks that have changed since a previous backup. This helps
with the disk space usage and reduces the backup times significantly.
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Oracle 10g has introduced a new feature called “block change training”. This feature provides significant
improvement for incremental backups. Contact your DBA about how to implement this feature.
The following examples of RMAN backup and restore are extremely simplistic and are included on to illustrate
basic concepts. By default, Oracle uses the database control files to store information about backups. Normally,
you will prefer to set up an RMAN catalog database to store RMAN metadata. Read the Oracle Backup and
Recovery Guide before implementing any RMAN backups.
rman target sys/*** nocatalog
run {
allocate channel t1 type disk;
backup
format '/app/oracle/db_backup/%d_t%t_s%s_p%p'
( database );
release channel t1;
}
Example RMAN restore:
rman target sys/*** nocatalog
run {
allocate channel t1 type disk;
restore tablespace users;
recover tablespace users;
release channel t1;
}

Export/Import Data Pump
Oracle introduced the export/import data pump in the 10g release. The import pump is twenty times faster than
the conventional import utility. Export/Import data pump utilities are “logical” database backups (not physical)
as they extract data and logical definitions from the database into a file. Export/Import data pump utilities do
not fit into 24/7 model because they do not offer roll-forward capabilities. Export data pump provides a snapshot
of the database schema as it was at a particular time.

Recommendations
Borland strongly recommends the use of RMAN backups if your enterprise wants to run a StarTeam instance
in a 24/7 environment. RMAN has evolved over the last few years and Oracle Corporation continues to add
features that make disaster recovery easier, more reliable, and faster.
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Oracle Database Tuning
This section provides the basic information needed to create an Oracle schema for StarTeam Server. Borland
recommends using the Administration tool to create the schema, but if you prefer to create your own, follow
the guidelines provided in this section.

Recommended Initialization Parameters
The following two tables recommend Oracle parameter settings for use with StarTeam databases.
Parameter

Recommended Value

Compatible

•
•

10gR2: 10.2.0
11g: 11.1.0.0.0

Cursor_sharing

•
•

10gR2: Force
11g: Force

Log_checkpoint_interval

Greater than the redo log size

Log_checkpoint_timeout

0

Workarea_size_policy

Auto

Db_block_size

16384 (16k)

Db_file_multi_block_read_count

16

Optimizer_mode

first_rows

Timed_statistics

True

Open_cursors

400

Undo_management

Auto

Undo_tablespace

(Name of the undo tablespace)

Undo_retention

28800

Processes

250

Statistics_level

Typical

Table 1: Common Database Configuration Parameters

112

Total Memory

Recommended 10gR2 Settings

Recommended 11g Settings

1 GB

SGA_TARGET = (Total Physical
Memory * 80%) * 60%

MEMORY_TARGET = Total Physical
Memory * 75%

We assume that 20% of the total
memory will be used by the OS.

We assume that 20% of the total
memory will be used by the OS and that
the Oracle instance is running on a
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Total Memory

Recommended 10gR2 Settings

Recommended 11g Settings

Statistics level should be TYPICAL or
ALL.

dedicated machine. Statistics level
should be TYPICAL or ALL.

LOG_BUFFER = 524288

LOG_BUFFER = 524288

PGA_AGGREGATE_TARGET = (Total
Physical Memory * 80%) * 30%
30% of the non-OS available memory.
This is the starting value.This may need
to be adjusted upwards.
2 GB

SGA_TARGET = (Total Physical
Memory * 80%) * 60%

MEMORY_TARGET = Total Physical
Memory * 75%

We assume that 20% of the total
memory will be used by the OS.
Statistics level should be TYPICAL or
ALL.

We assume that 20% of the total
memory will be used by the OS and that
the Oracle instance is running on a
dedicated machine. Statistics level
should be TYPICAL or ALL.

LOG_BUFFER = 1048576
PGA_AGGREGATE_TARGET = (Total
Physical Memory * 80%) * 30%

*LOG_BUFFER = 1048576

We assume that 20% of the total
memory will be used by the OS. This is
the starting value. This may need to be
adjusted upwards.
4 GB

SGA_TARGET = (Total Physical
Memory * 80%) * 60%

MEMORY_TARGET = Total Physical
Memory * 75%

We assume that 20% of the total
memory will be used by the OS.
Statistics level should be TYPICAL or
ALL.

We assume that 20% of the total
memory will be used by the OS and that
the Oracle instance is running on a
dedicated machine. Statistics level
should be TYPICAL or ALL.

LOG_BUFFER = 1048576
PGA_AGGREGATE_TARGET = (Total
Physical Memory * 80%) * 30%

LOG_BUFFER = 1048576

We assume that 20% of the total
memory will be used by the OS. This is
the starting value. This may need to be
adjusted upwards.

Table 2: Database parameters based on total memory

Oracle Database Monitoring and Tuning
The most efficient way to tune your oracle database is to start with the recommended database settings and
monitor the instance using the advisories. In addition to that, Borland recommends the use of Automatic
Workload Repository (AWR) to collect performance statistics, including wait events used to identify performance
problems. A detailed description of AWR is beyond the scope of this document. Please refer to your Oracle
10g performance tuning guide for more information.
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Oracle 10gR2 Databases
This section provides information about tuning Oracle 10g databases.

Automatic Shared Memory Management
Oracle 10g introduced Automatic Shared Memory Management (ASMM) of individual SGA components like
shared pool, java pool, large pool and db cache. You do not need to estimate when setting the size of SGA
components. In fact, there is no need to set any parameters defining SGA size.
All you have to do is to set a new parameter called SGA_TARGET. The parameter SGA_TARGET takes a
value which indicates the maximum size of SGA required for your instance.
Consider that you set SGA_TARGET to say 800MB. This indicates that maximum size to which SGA can grow
is 800MB. All the SGA components like shared pool, buffer cache, large pool, java pool will be allocated from
this 800M maximum SGA. Oracle will automatically calculate the initial size of these components and resizes
it as per the requirement without any manual intervention.
You do not have to explicitly define values for shared pool, buffer cache, large pool and java pool if you set
SGA_TARGET. The SGA_TARGET will be limited by the SGA_MAX_SIZE value. The SGA_MAX_SIZE cannot
be modified dynamically. If SGA_MAX_SIZE is not set, both the parameters have the same value and it will
be not possible to increase the size of SGA_TARGET dynamically.

Automatic Segment Space Management
The Automatic Segment Space Management (ASSM) feature allows Oracle to use bitmaps to manage the
free space within segments. The bitmap describes the status of each data block within a segment with respect
to the amount of space in the block available for inserting rows. The current status of the space available in a
data block is reflected in the bitmap allowing Oracle to manage free space automatically with ASSM.
ASSM tablespaces automate freelist management and remove the ability to specify PCTUSED, FREELISTS,
and FREELIST GROUPS storage parameters for individual tables and indexes created in ASSM tablespaces.
The values for parameters PCTUSED and FREELISTS are ignored and Oracle automatically manages the
space for these tables and indexes inside the tablespace using bitmaps. PCTFREE can still be specified and
is used with ASSM.

Oracle 11g Databases
This section provides information about tuning Oracle 11g databases.

Automatic Memory Management (AMM)
Beginning with version 11g, the Oracle database can automatically manage the SGA memory and the instance
PGA memory. You only need to designate the total memory size to be used by the instance, and the Oracle
database will dynamically exchange memory between the SGA and the instance PGA as needed to meet
processing demands. This capability is referred to as automatic memory management. With this memory
management method, the database also dynamically tunes the sizes of the individual SGA components and
the sizes of the individual PGAs.
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AMM is implemented using Memory_Target and Memory_max_target parameters. Use of
MEMORY_MAX_TARGET is optional. When MEMORY_MAX_TARGET is not set, Oracle automatically sets
MEMORY_MAX_TARGET to the value of MEMORY_TARGET.
To switch to AMM, define the value of MEMORY_TARGET in the spfile. It is important to ensure that the values
of SGA_TARGET and PGA_AGGREGATE_TARGET are set to 0. Customers upgrading to 11g instance must
set the value of SGA_TARGET and PGA_AGGREGATE_TARGET to 0.
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